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Intfroduction

1. Introduction

The AxTrax AS-525 Access Control System® is a complete software
management system for use with AC-215, AC-225 and AC-525 Access
control panels.

The AxTrax AS-525 Access Control System@ is user-friendly, intuitive, and rich
in functionality. The system can manage up to 30,000 users and offers
complete control over up to 4092 doors (with MD-D02 reader expansion
board). Using AxTrax AS-525, configured doors by area and time, for
different types of personnel and for varying alarm situations.

The AxTrax AS-525 Access Control System® is capable of integrating with
Video Surveillance software “ViTrax”. The main purpose of the integration
is to enable video recording based on access control events and
convenient playback.

This Manual is compatible with AxTrax AS-525 software Version 00.03.17
and above, as well as ViTrax Version 1.6.15.15382.

1.1 System Features

The AxTrax AS-525 makes it possible to control and monitor every aspect of
access control on a site. The system includes an in-built software security
system that controls access to the system database and logs all
operations performed. In addition, the system boasts the following
Professional Grade Features:

Free basic level-0 server software license for up to 64 panels (ACU's).
Three incremental license levels can be activated by buying a
Rosslare HASP key (CD-ROM is provided with the package)
User-friendly PC software with intuitive layout reduces complexity of
access control

Manages user data, photo and information fields, access rights,
alarms, strike fime, and door mode, all from one central location
Produces reports from acquired data, such as entry and exit times,
and any types of alarms, by user, location, and time

Available in a large variety of languages

Compatible with additional software modules from Rosslare for time
and Attendance and photo ID card development

Backward compatibility with VeriTrax AS-215 and AS-225

Access Control

Access groups define access rights for every part of the site. Access rights
are time dependent— for example, users in the "Mornings Only" access
group could have access to certain areas of the site between 9am and
12pm only.

Every user is assigned to an access group. The system also stores an
identification photograph and personal details for each user and user
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specific access settings, such as Antipassback immunity; requirements for
an extended open door period; configurable special privieges and
friggered outputs.

Access Monitoring

The AxTrax AS-525 records every attempt to open a door within the site.
Status maps show the state of every part of a facility, while an Events log
records complete details of every time access granted or denied for
every door on site while also monitoring possible door tampering and
forced entries.

The AxTrax AS-525 can also produce a variety of access reports, including
usage reports, attendance records and roll calls. Using the AxTrax Report
Wizard, users can design their custom reports to meet their specific needs.

Software Security

Access to the AxTrax AS-525 software is password conftrolled. It is possible
to grant different operators restricted security rights, with access to only
specified elements of the system or with read-only access.

1.2 AxTrax Server and Client

The AxTrax AS-525 system includes both the AxTrax AS-525 Server and the
AxTrax AS-525 Client software.

AXTrax AS-525 Server should be installed on the computer that will control
the Access control panels and manage the database. It includes a full
suite of administrator functions, including the ability to change panel
network parameters, download new firmware to individual access conftrol
panels and manage the AxTrax AS-525 database.

Additional computers can use the AxTrax AS-525 Client software, which
connects to the panel network through the AxTrax AS-525 Server. The
AxTrax Client has a limited operation set, and can only send or receive
information from Access Control panels when the AxTrax Server is
operating and connected to the panel network.

One AxTrax AS-525 Server can serve an unlimited number of AxTrax AS-525
Clients.

1.3 Using this User Guide

This user guide provides all the information required to start working with
the AxTrax AS-525, refer to the AC-215, AC-225 or the AC-525 hardware
manuals for wiring and installation.

How to install the AxTrax AS-525 on a computer

The basic functionality of the AxTrax AS-525

How to set-up the AxTrax AS-525 for a new site

How to monitor and manage a site using the AxTrax
AS-525

AS-525 AxTrax Software Installation and User Guide Page 6
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2. Specifications and Requirements

2.1 System Capabilities

General
Software Architecture Client - Server
Database type SQL Server 2005
Max. of Users 30,000
Max. Access Groups 30,000
Max. Number of Time Zones 32
Max. Cards per User 16
Max. Number of Doors 4092
Max. Access Control Panels 1023
Antipassback e Timed
e Door
e Global - Across an entire Facility
International Holiday Support 64
Networks
Max. Number of Networks 1023
Supported Access Control Panel e AC-215
Models o AC-215 (SPV)
o AC-225

o AC-225 with MD-1084
e AC-225 with MD-D02
¢ AC-525 with MD-1084
¢ AC-525 with MD-D02

Panel Networks communication o Serial (RS-232)

interface . TCP.IP
¢ Modem
Communication speed 9600-115200 bps
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2.2 System Requirements

AxTrax AS-525 System Minimum Requirements

Operating System Windows XP SP2, Windows Vista

Processor Pentium 4 or better

Memory 256 MB (512 MB recommended)

Network LAN card required for TCP/IP
networking

Hard Disk space 1.5 GB (500 MB free space)

SQL Express Server Minimum Requirements
(SQL Server Express is not always required. See Choosing an SQL Server,
page ?.)

Operating System Windows XP SP2, Window Server
2003, Windows Vista

Processor Pentium 4 or better

Memory 256 MB (512 MB recommended)

Hard Disk space 600 MB (256 MB free space)

HASP USB Key Requirements

1-64 active panels HASP key not required

65-256 active panels Level 1 HASP key required
257-512 active panels Level 2 HASP key required
513-1023 active panels Level 3 HASP key required
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3. Installation

The AxTrax AS-525 installation CD-ROM includes all the set-up files required
fo run the AxTrax Server or Client on a computer.
The installer includes the following elements:

Microsoft™ SQL Server 2005 Express

Microsoftf™.NET 2.0 Framework

AXTrax AS-525 Access Control System (Server or Client version)
HASP key confroller (AxTrax Server only)

I'm SQL Server Express and the Microsoft .NET Framework are pre-
requisite software and are not installed unless required.

3.1 Choosing an SQL Server

The AxTrax Server operates using an SQL database. If there is already an
SQL server available on your computer network, use it to run the AxTrax
database.

Alternatively, install the Microsoft SQL Server Express on the computer that
will be used as the AxTrax server.

ilm] Do not install the SQL server for AxTrax Client installations. AxTrax
Clients connect to the AxTrax Server database.

3.2 Starting the AxTrax Installer

Install the AxTrax AS-525 Access Control System using the installation CD-
ROM.

To begin installing the AxTrax AS-525:
1. Insert the CD into your computer's CD drive.

2. Open My Computer, double-click on the CD drive icon and then
double-click the AxTrax AS-525 setup file.

If the setup detects a previous version of AxTrax AS-525, a prompt will
appear asking if you want to upgrade AxTrax AS-525 to the newer
version. Note that upgrading to the newer version will only use current
database information. Downloading of panel information is required
after upgrading the AxTrax AS-525 version.

If there is no SQL server installed, the Installation Requirements window
opens.
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InstallS hield Wizard

@ AxTrax 45525 requires that the following requirements be installed on your computer prior
i

to installing this application. Click O to begin instaling these requirements:

| Status Requirement
| Extracting Microsoft SAL Server 2005 Express

Ertracting: Microsoft SOL Server 2005 Express. SOLE<PR.EXE
T O T T T T LT T LT )

Cancel

Figure 1: Installation Requirements window
3. Click Install.

If there is no SQL server installed, the following dialog appears: *AxTrax
AS-525 optionally uses Microsoft SQL Server 2005 Express. Would you
like to install it now?”

If you are installing AxTrax Client or if there is already an SQL server
available on the computer network, click No.

Otherwise, click Yes to install SQL Server Express.

i'm Install AXTrax Server on the computer that will connect to the
Access confrol panels and manage the database.
Install AxTrax Client on any additional computers.

4. If the Microsoft .NET 2.0 Framewaork is not installed on the computer,
the following dialog appears: “AxTrax AS-525 optionally uses Microsoft
® .NET 2.0 Framework. Would you like to install it now?"

Click Yes to install Microsoft .NET Framework.
Follow the on-screen instructions to complete the installations.

3.3 Installing AxTrax AS-525

After the installer has added any pre-requisite software to the system, the
AxTrax AS-525 Install Shield Wizard installs the software.

AS-525 AxTrax Software Installation and User Guide Page 10
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InstallShield Wizard

Preparing to Install...

AxTrax 85525 Setup is preparing the InstallShisld
Wizard, which will guicke you through the program setup
process. Please wait

Checking Operating System Yersion

Figure 2: Install Shield Wizard
To Install AxTrax AS-525:
1. Wait while AxTrax AS-525 prepares to install.

The Welcome to the Install Shield Wizard window opens.

% AxTrax AS-525 - InstallShield Wizard 3

welcome to the InstallShield wWizard for
AxTrax AS-525

The InstallShield{R) Wizard will install AxTrax A3-525 on vour
computer. To continue, click Mext.

WARNING: This program is prokected by copyright law and
international treaties,

: Back et 1 [ caneel |

Figure 3: Welcome to the Install Shield Wizard window
2. Click Next.

The Select Database Server window opens.
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1% AxTrax AS-525 - InstallShield Wizard

Database Server

Select database server and authentication method

Select the database server toinstall to from the list below or click Browse to see a list of all
database servers, You can also specify the way to authenticate your login using your current. .

In case of SolExperss you need to add the instance name Weritrax' to the computer name,
for example: ‘Computer1iVeritrax’
Database Server:

w ' Browse. ..
Connect using:
(O windows authentication credentials of current user
(%) Server authentication using the Login ID and password below
LognID:  |sa
Bassword:  [reerer
[ <Back || mets ][ Cancel |

Figure 4: Select Database Server window
Select the database server name.

On AxTrax Client installation it is likely that the database server was
installed on another PC, click Browse to select the database server
location.

If the database server used was installed from VeriTrax setup program
("SQL Server express”) than the instance name "\VeriTrax" should be
added to the database computer name

Set the "Connect using" to the default option ( "Server authentication
using the login ID and password below" ) The only condition for
setting "Windows authentication" is when using existing SQL database
NOT installed from VeriTrax setup, and only if it was installed using
Windows authentication.

Click Next.
The Setup Type window opens.

i& AxTrax AS-525 - InstallShield Wizard

Setup Type
Choose the setup type that best suits your needs. S

Please select a setup bype.

®server
All pragram features will be installed. (Requires the most disk
space.)

() Client
orly client tools will be installed. (Required server instllation
before.)

[ <Back  J[ mext> | [ concel |

Figure 5: Custom Setup window
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7. Toinstall AxTrax Server, select Server from the list.
_Or_

To install AxTrax Client, select Client from the list.

I'm AxTrax must be first installed as AxTrax Server.
Installing AxTrax Clients is optional. It can be useful for monitoring
the system from more than one PC.
8. Click Next.
The Destination Folder window opens.

1% AxTrax AS-525 - InstallShield Wizard

Destination Folder 4
Click Next ko Install to Hhis Folder, or click Changs ko instal to a diferent Folder., =
Install AxTrax AS-525 o
| ] CiiProgram FllesiRosslare! AxTrax AS-525)
[ <Back | Ttz | [ Cancel |

Figure 6: Destination Folder window

9. To select a new destination folder for AxTrax AS-525, click Change
and browse to the required folder.

10. Click Next.
The Ready to Install window opens.

1% AxTrax AS-525 - InstallShield Wizard X

Ready to Install the Program

The wizard is ready to begin installation. -

Click Install to begin the installation,

1F you wanit b review or change any of your installation settings, dick Back, Click Cancel ta
exit the wizard.

[ <pack [ ostal ) [ cancel |

Figure 7: Ready to Install window
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11. Click Install.
The installation process begins.

1% AxTrax AS-525 - InstallShield Wizard
Installing AxTrax AS-525

The program Features you selected are being installed.

Please wait while the InstallShield Wizard installs AxTrax A5-525, This may
take several minutes,

Status:

< Back et > i Cancel

Figure 8: Installing AxTrax AS-525 window

12. When the installation is complete, the Install Shield Wizard Completed
window opens.

i% AxTrax AS-525 - InstallShield Wizard |z\

Installshield wizard Completed

The InstallShield Wizard has successfully installed AxTrax
A5-525, Click Finish to exit the wizard,

Figure 9: Install Shield Wizard Completed window

13. Click Finish and restart the computer if requested.

During Server installations, a dialog appears while the HASP key
protection software is installed.

The AxTrax AS-525 Access Control System is now fully installed on the
computer.
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3.4 Firewall Settings

Internal firewall settings may prevent the AxTrax Server connecting to the
SQL database or to panel control units using TCP/IP.

For more information on how to configure a firewall, see Appendix A.
Firewall Configuration, page 91. Contact your system administrator or
Rosslare Technical Support for further guidance.

3.5 SQL Server Settings

After installing the AxTrax, verify that the SQL server service on the
computer is running and set to the required installation.

For more information on SQL servers settings, see Appendix B, page 96.

If the SQL Express 2005 is installed (part of the installation package),
the installation must be on the same Windows XP user account that
is being used for AXTrax.

3.6 Camera Installation & Requirement Steps

AxTrax AS-525 can connect with single or multiple ViTrax Servers installed in
a LAN or WAN configuration (up to 10 ViTrax Servers are supported).

i'm Make sure fo check AxTrax AS-525 and ViTrax version compatibility.

To Install ViTrax Server and Client applications, refer to the ViTrax Software
manual.

ilm] When installing the AxTrax AS-525, make sure that the ViTrax Server
has already been installed on the same PC (no license required for
that ViTrax Server).

To Install Cameras:
Activate ViTrax Server and Client (see ViTrax Software manual).

N~

Define ViTrax Servers (see 65).

Define communication of AC-525 cameras to the ViTrax Server
(see Defining communication of AC-525 cameras to the ViTrax
Server).

4. Activate AxTrax AS-525 and configure it (see System Overview and
How to Set Up a Site).
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4. System Overview

The AxTrax AS-525 is controlled through an easy to use interface, with a

free-view list of all aspects of the site set-up and a toolbar for standard
operations.

4.1 Starting the Software

This section explains how to start the software and login to the main
window.

To start the AxTrax AS-525:

1. Click on the AxTrax AS-525 icon on the desktop, or select the program
from the Rosslare folder in the Start menu.

el
Figure 10: AxTrax AS-525 Access Control System Icon
The AxTrax Software login dialog appears.

% AxTrax AS-525 Software ¥ 0.03.16 E]
% Phass chack name and anler pasevsesd
Dasaka nams
|administrator v
rm
(14 Carwoecd |

Figure 11: AxTrax Software Dialog box
2. Select an Operator name and enter a password.

i'm By default, the Administrator operator password is "admin®.

The SW versions in the screenshots are exemplary only
3. Click OK.

The main AxTrax AS-525 window opens.

AS-525 AxTrax Software Installation and User Guide Page 16
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4.2 The AxTrax AS-525 Main Window

All the central functionality of the AxTrax AS-525 is available from its main
window.

[SEIES

+ - Ac

es
Aec
27 G shach
# Cads
- fif Depanments\sers

AxTrax
Y |

o Operators
Copyight [c] 2008 Posslare Enterprises Lid

=) Reparts E

% Server administrator 28/01/2008 | 0957

Figure 12: AxTrax AS-525 Main window
The AxTrax AS-525 Main window is divided into five sections:

1 Menu Controls the general operation and set-up of the software. For
Bar more information, see Menu Bar, page 18.

2 Toolbar Use the toolbar icons for the key tasks required in managing
access control across a facility. The available icons change
according to the view selected. For more information, see
Toolbar, page 19.

3 Tree The tree view allows users to configure, monitor and control
View every aspect of a facility access control. For more
information, see Tree View, page 21.

4 Display Displays all items within the free view selected element.
Area

5 Status Displays general status information such as: Operator name,
Bar client or server mode, system readiness, system download,
date and time.
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4.3 Menu Bar

The menu bar controls the general operation and set-up of the software.

File Menu
The File menu has four options:
Menu Description
Logon Log on to the AxTrax AS-525 system.
When you log on as a new Operator, the previous
Operator will be logged out.
Logoff Close the current Operator account.
The AxTrax software is minimized to the taskbar.
SQL Server Logon Log on fo the SQL database server.

ViTrax Server

Log on fo the ViTrax server.

Exit

Exit the AxTrax AS-525 software.

Tools Menu

Use the Tools menu to manage the database and set software
preferences. The menu has three opftions:

Menu Description

Database Open the Database window to backup the database
or set a scheduled backup and to import or export the
AxTrax AS-525 and/or VeriTrax AS-215/AS-225
configuration states and Events logs.

Options Set software options and preferences, including
national holidays, event highlighting, pop-up alarms,
custom user information fields and Reports settings.

Import Data Import user information from an Excel spreadsheet file.

Help Menu
The help menu has one opftion:
Menu Description
About Software version information.

AS-525 AxTrax Software Installation and User Guide Page 18
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4.4 Toolbar

The toolbar controls key tasks required to manage access control across a
facility. When a new element is selected from the tree view, the toolbar
icons change fo suit the selected element.

The following toolbar icons are available:

General Icons

Icon

Name

Description

1

Open Door Manually Opens the Door Manual Operation

window. See Controlling the Door
Manually, page 72.

5 Print Send the current display area view to the
g printer.
a New Create a new element of the selected
type.
= Edit Edit the selected element.
« Delete Delete the selected item.
ad) Delete All Remove all users or cards from the
selected list.
Events Icons
Icon Name Description

Pause Pause the display of events in the display area.

i1 New events will be shown again when the
Pause button is clicked a second time.

View Events Displays all Events that occurred within the last
] within the las our. Click the drop-down arrow to change
@ ithin the last h Click the d d toch

Hour the view.

View Events Displays all Events that occurred within the last
3] withinthelast  two days. Click the drop-down arrow to

Day change the view.

View Events Displays all Events that occurred within the last
7 within the las week. Click the drop-down arrow to change
| ithin the last k. Click the d d to ch

Week the view.

View Periodical Displays all Events that occurred within a
._ﬂ Events selected period. Click the drop-down arrow to

change the view.

Page 19
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(3]

View All Events  Displays all Events. Click the drop-down arrow
to change the view.

|:l_u

Antipassback Opens the Anfipassback Forgive window,
Forgive allowing the operator to cancel an
antipassback restriction for the selected user.

i Show User Opens the User window for the selected user.
& Clear Alarm Opens the Alarm Details window, allowing the
operator to reset the alarm.
it Archive Opens Archive Camera Window for the
= selected Video Stream.

Networks Icons

Icon

Name Description

ey

Update Firmware Send a firmware update to the selected access
conftrol panel.

One Reader per Displays new panel with single reader per door

| Door (with/without extension panel). See Adding
Access Control Panels, page 28.
Two Readers per Displays new panel with two readers per door
b | Door (with/without extension panel). See Adding
Access Control Panels, page 28.
5! Set Time Set the time on the selected Access Control

Panel. See Setting the Time and Date, page 79.

%

Find Panels Find and update panels within the network. See
Detecting Panels Automatically, page 79.

i
©

Modem Manual Opens the Modem Status window, allowing the

= operator to connect or disconnect the modem
and change the connection password.
-, Camera View a list of camera’s connected and assign
- camera’s o panels, page 67.
Panel Icons
Icon Name Description
Manual Change the operation mode of the readers

J Reader on the selected panel. See Changing the

Reader Mode, page 73.
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Icon Name Description

Control Output Change the settings for the outputs on the
[: Manually selected panel. See Controlling Outputs
Manually, page 74.

Control Input Change the seftings for the inputs on the
:] Manually selected panel. See Manually Disarming
Inputs, page 75.
a Control Siren Test the siren for the selected panel. See
= Manually Testing the Siren, page 76.
Manually Update the selected panel. See Manual
’J Download new  Download of Panel Data, page 80.
Panel Data
Manually Downloads the entire Panels Failed database.
| Download failed See Downloading Failed Data: page 81
Data

Departments\Users Icons

Icon Name Description
Q Find Users Search for a user in the database.
1 User Counter  View current User count value.

See Testing User Counters: page 82

Reports Icons

Icon Name Description

5 Produce Report Produce the selected report.

4.5 Tree View

The Tree View allows users to configure, monitor and control every aspect
of a facility's access control network.

When the user selects an element from the tree, its contents are shown in
the main display area and the toolbar icons change to suit the selected
element.

Events

The Events log displays a log of every time access was granted or denied,
for every door on a site. Monitoring for potential door tampering or forced
entry, is logged and displays of internal system warnings, including Video
stream archive are saved fo the ViTrax database.
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Status Map

The Status Map displays the status of every door, reader and alarm in the
facility on user-selected floor plans.

The system can display multiple nested status maps, allowing users to show
either the complete access control network or a specific area in detail.

Networks

A network is a group of up to 32 access control panels. The AxTrax Server
connects to the panels across the panel network. The AxTrax AS-525 can
support up to 1023 panel networks. For more information, see Defining a
Network, on page 26.

Time Zones

To work with 65 panels or more, a HASP security key must be
connected fo the AxTrax Server machine.
See System Requirements, page 8.

Defines a weekly time period or set of time periods, for example, "Office
Hours" or "Out of Office Hours". Door access rights, alarms and input and
output behavior can all be set to behave differently within each Time
Zone. For more information, see Defining Time Zones, page 25.

Access Groups

An Access Group defines when each reader on the site will be available
for access. All site personnel are assigned to appropriate Access Groups.
For more information, see Creating Access Groups, page 39.

Input and Output Groups

Input and output groups defines sets of outputs or inputs that should be
managed together within a panel. For more information, see Configuring
the Inputs, page 38.

Access Areas and Global Antipassback

A facility can be sub-divided into several access areas in order to
configure and manage it more effectively. Antipassback rules can be
applied for each access area to prevent one user's card or entry code
being used for two subsequent entries and o prevent a second entry
without a previous exit.

Creating Access Areas and Global Anfipassback Rules, page 50.
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Cards

Lists all cards in the system with their statuses, and allows the manual or
automatic addition of cards to the system. For more information, see
Defining Cards, page 41.

Departments and Visitors

Lists departments and users, as well as visitors. Every user is a member of a
department. It is possible to assign each user a card and/or a PIN code,
set access rights, personal details, and an identification photograph for
each user.

Creates visitors with their specific associated rights.

For more information, see Defining Users and Departments, page 44.

Holidays

Defines annual holiday dates. Using Time Zones, it is possible to set special
access behaviors for holiday time.

i'm Selected holiday dates can also be imported into the AxTrax AS-525
from Microsoft® Outlook®.

Operators

Operators are people with access to the AxTrax software. The default
operator names are administrator, engineer and security.

Different operators have wider or more restricted security rights, from
complete confrol over the system to the ability only to view one section.
All Operator passwords are case-sensitive.

Reports

AXTrax can produce various reports, including usage reports, attendance
records, visitors, and roll calls. The AxTrax Report Wizard allows users to
design their own custom reports, based on their needs. For more
information, see Reports, page 77.
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5. How to Set Up a Site

This section outlines a suggested step-by-step process for configuring the
AxTrax AS-525 for asite.

Action Section

Define the Time Zones See Defining Time Zones, page 25.

Define a Network See Defining a Network, page 26.

Define and Configure an See Adding Access Control Panels,

Access Control Panel page 28.

Configure the Doors See Setting Door Properties,
page 33.

Configure the Readers See Configuring the Reader,
page 35.

Configure the Inputs See Configuring the Inputs,
page 38.

Create Access Groups See Creating Access Groups,
page 39.

Define new Cards See Defining Cards, page 43.

Set-up new Users See Defining Departments, Users, and

Visitors, page 45.

Define Access Areas and See Defining Access Areas and

Antipassback Antipassback, page 51.
Set Panel Links See Sefting Panel Links, page 53.
Create a Status Map See Creating Status Maps, page 57.

-
o
=

The AxTrax AS-525 system performs an automatic data download for any
parameter related to the hardware. If panels are connected and active,
"Downloading" will appear on the status bar after any downloaded
parameter change. "Ready" appears when download is complete,
however it may also appear after a failed download.
r | Note: . . |
I'm It is the operators’ responsibility to verify that the download operation
succeeded or failed. This can be verified in the system event list or by
checking the download failed data manually, see page 81 .
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5.1 Defining Time Zones

A time zone is a group of periods within a week. Door access rights, alarms
and input and output behavior can all be set to behave differently for
each Time Zone. Many operations can automatically enable or disable
within a selected time zone.

The Time Zone Properties window displays the selected periods for each
day in the week. It is possible to set a maximum of eight different periods.

To set a new time zone:
1. Select Time Zones from the tree view.

Click the New icon o on the toolbar.
The Time Zones Properties window opens.

Time zone Properties @

Description

|Ofice Hours

[ St | End [ Sun [ Mon [ Tus [wed [ Thu | Fi | Sat | Hol
I E S f f S S
wsfms S S LA A
’7_,7_

’7_,7_

’7_,7_

’T,T

Clear Al oK | Cancel |

I I ) B Y ) S R

Figure 13: Time Zone Properties window

The Time Zone Properties window contains the following fields:

Field Description

Description  Enfer a name for the time zone.

Start / End Enter a start time and an end time for each period.

Sun-Hol Select the days on which the time period is within the time
zone.
The "Holiday" day can be set to include national holidays.

Clear All Clear all the time zone settings.
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2. Enter a name for the time zone and set the required time periods.
Click OK.

The window closes and the display area displays the new time zone.
I'||| Time settings can be copy-and-pasted between time zones.
Right-click on a time zone and select Copy from the shortcut

menu then Right-click on a second fime zone and select Paste
from the shortcut menu.

5.2 Defining a Network

The AxTrax AS-525 communicates with each access control panel as part
of a network. A network is a group of up to 32 access control panels.
The Network window includes the following information:

The network's name, address and status
The DIP switch settings for the communication speed
The type of network connection and the connection settings

To access the network window:
1. Inthe Tree view, click Networks, and from the Network toolbar, click

]
New .
The Network window is displayed.

Description
Hetwork 1 [ 1

¥ Enabled

Metwork lype

Serial -

Serial Metwark:

Com Port
COM1 -

Speed

9600 -

Advanced ‘ oK | Cancel ‘

Figure 14: Network window
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The Network window contains the following fields:

Field Description

Description Enter a name for the network. The network address
for the network is shown to the right of the network
name.

Enabled Enable the checkbox when the network is
connected and operational.

Network Type Select the Network type: Serial, TCP/IP or Modem.

See Network Configuration, on
page 98.

Serial / TCP/IP /
Modem Network

Set the connection type and speed.

For TCP/IP connections, set the IP Address.
See Network Configuration, on

page 98.

Configuration

Opens the Configuration window to set
communication preferences. This button appears
when selecting a Modem or TCP/IP LAN network. For
more information, see Network Configuration, page
98.

Advanced

Sets the Maximum Communication timeout for panel
response time; Set to "Slow" if panel response is not
consistent. This condition may occur due to busy
TCP/IP network or when connecting panels on a
WAN in remote sites

2. Enter a name for the new Network in the Description box and select
the Enabled check box.

Select the Network type and set the connection settings.

3. For a Modem, click the Configuration button to set dialing
preferences for the computer's modem and the receiving modem.

4. For a TCP/IP LAN, click the Configuration button to locate the
hardware on the local network.

For more information on how to configure an access control network,
see Network Configuration, page 98. Check with your system
administrator for more information, or contact Rosslare technical
support (see Technical Support, page 105), Un-check the "Enabled"
checkbox if you wish to pause communication to panels on the

network.

Page 27

AS-525 AxTrax Software Installation and User Guide



How to Set Up a Site

ilm] Access control panels connect to a TCP/IP network via a MD-N32
TCP to Serial converter or using the on board converters in AC-225
or AC-525. Refer to the relevant hardware installation guides for
more details.

5.  For dll types of network, set the DIP switch on the Access control
panel hardware to match the diagram at the top of the screen.

I'm Make sure to power-down and then power-up the panels after
changing DIP switch.

5.3 Adding Access Control Panels

Every network is a cluster of access control panels. Each Panel can be
configured using two readers per door when the door acts as both the
entrance and exit to an area of the site. In their standard form, each
access control panel has two readers and it can be configured as either
as single door with two readers or as two doors with one reader per each
door. When using optional MD-D02 readers expansion board (supported
by AC-225 or AC-525) each panel will have four readers and can be
configures as four doors panel.

Use two readers per door when one door acts as both the entrance and
exit fo an area of the site. When only an enfry reader is required, use one
reader per door.

For example:

Use configuration with two readers per door set to IN and OUT, to
produce attendance reports.

Use one reader per door configuration to control two doors with "IN"
reader only (exiting the premises will be by REX switch or by
mechanical door handle only).

General Panel Settings

The General tab of the Door Controller Panel Properties window displays
the following:

The panel's address and status
The DIP switch settings for the panel,
If panel expansion boards are installed:

The input and output connections for the panel

The panel's hardware version
Refer to AC-525 Hardware manual for further details on panel
configurations.
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To add a panel:
1. Inthe tree view, click on Networks.
The available networks are listed in the display area.
2. Select a network.
For one reader per door on the Access Control Panel, click the One
Reader per Door icon H .
For two readers per door on Access Control Panel, click the Two

. ]
Reader per Door icon ] .

' ] Make sure that Dip Switch 3 position on the panel corresponds with
it's position demonstrated on the panel properties window.
The Door Controller Panel Properties window opens.

=

Panel properties =
General 1 Optians
Deseriplian Hardware version
|54Panel 1 1 =1
e 4Doars - 4 Feaders
5\ ¥ Enabled
R
Input | Function [ Output Function
Input 1 Door 1 REX Dutput 1 Door 1 lack
Input 14 Do 1 honiter Ouiput 14 General pupose
Input 2 Door 2 REX Ouiput 2 Door 2 lack
Input 26 Diowr 2 honiter Ouiput 24 General pupose
Input 5 Door 3 REX Ouiput 5 Dioor 3 lack
Input & Diar 3 Monitar Ouiput 6 General puipese
Input 7 Door 4 REX Ouiput 7 Dioor 4 lack
Input & Dioar 4 Monitar Ouiput 8 General puipese
Test e Conced |

Figure 15: Door Controller Panel Properties window
The Door Controller Panel Properties window contains the following fields:

Field Description
Panel Enter an address number for the panel.
Address The network's address is displayed to the left of the panel

address. Valid entries are 1-32.

Hardware  Select the appropriate panel hardware type.
Version

Enabled Enable the checkbox to activate this panel.
Clear the checkbox if the panel is not connected.
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Field Description

Upload Enable the checkbox to send previous logged events from

Previous the panel.

Events

Inputs Displays the input connections for the panel.

Outputs Displays the output connections for the panel.

Test Click to test the panel is correctly connected to the
computer.
The Test Panel window displays hardware details including
hardware type, firmware and bootloader versions, and
indicates whether an I/O expansion board is installed on the
panel.

3. Select the appropriate Hardware Version for your panel.

Ensure that the DIP switch on the panel matches the diagram at the
top of the screen.

Click OK. The window closes and the display area displays the new
Panel.

i'm] After a panel is connected, AxTrax AS-525 can also detect and

add it automatically. For more information, see Detecting Panels
Automatically, page 79.

Configuring the Panel

Each panel has individual settings for antipassback behavior and for
recording events.

Once the panel is connected, configure a panel's options from the
Options tab in the Door Conftroller Panel Properties window.

_

When there is communication with the panel the Tx and Rx LEDs
flash.

To configure a panel:

1.

In the tree view, click on Networks.
The available networks are listed in the display area.
Expand a network in the tree view and select a panel to configure.

=
Click on the Edit icon
The Door Controller Panel Properties appears.
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General | diptions
Do sntipasshack.
Automatic antipassback. " Hard [alaim and access denied)
[riever € Soft alarm anly)
IN Readers: OUT Readers:

™ 1\Panel 1 ‘\Reader 1
™ 1\Panel 1 \Reader 2
[ 1%Panel 1 \Reader 3
[ 1%Panel 1 ‘\Reader 4

Evwents filter

& Select isported events.

Door Interlock,
v Enabled

Iv Doorl [~ Door 3
v Door2 [~ Door 4
Test 0K ‘ Cancel |

Figure 16: Door Controller Panel Properties Options tab
The Options tab contains the following fields:

Field Description

Automatic Select the time zone for door antipassback rules to apply.

Antipassback

Hard When hard antipassback is selected, an event is
generated and the door does not open.

Soft When soft antipassback is selected, the door opens but
an event is generated.

Reader 1-4 Enable the checkboxes to apply antipassback
restrictions to Reader 1 thru Reader 4 as required.
Only when the check-box is checked is the reader
Antipassback enabled.

Select Open the Events Filter and select the Events this Panel

should record.
Set the filter's operation method:

e Always Active- Only the selected events are
recorded by the panel.

e Active when disconnected- If the panel is
disconnected from the AxTrax server, only the
selected events are recorded. When the panel is
connected to the server, all event are recorded.

Note: In default configuration, some events are filtered
and may not be seen in display area - events view.
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Field Description

Door Interlock  check the Enable checkbox to enable Door Interlock.
Check the Enable Door 1-4 checkboxes to apply the
Door Interlock restrictions to Doors 1-4.

The Door Interlock function is only enabled when the
Enable check boxes and a minimum of two Doors are
checked.

= Note:

I"' The Door Antipassback feature is now available for four doors. To
activate Antipassback, check the IN Reader / OUT Reader

check-box next to the appropriate reader/s. Interlock(for Panels

with 2, 4 Doors only) is preserved in order to open another door

when the current door is open.

3. Click on the Options tab.
4. Set Antipassback and event filtering for this panel and click Test.
The test screen displays the following information:

The Panel is connected.
Firmware version: ac22501_04_30
Bootloader wersion: bl ac225w 01_02
Hardware: AC-225
Supervized Inputs: ez
MD-1084: MNane
MD-D02 : Yes

Figure 17: Panel Connection Test

Field Description

Firmware version The firmware version of the board.
Bootloader The bootloader version of the board.
version

Hardware The hardware name.

Supervised Inputs The panel is secure in case of tampering.

MD-1084 MD-1084 does or does not exist
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Field Description
MD-D02 MD-D02 does or does not exist
5. Click OK.

The window closes and the display area displays the new Panel.
I'm A panel configuration can be copied-and-pasted between
panels. Right-click on a panel and select Copy from the shortcut
menu then Right-click on a second panel and select Paste from

the shortcut menu. Properties can only be copied between
panels of the same door controller type and hardware version.

5.4 Setting Door Properties

Every Panel controls one or two doors, or four doors if MD-D02 reader
extension board is connected. Each door can be configured individually.
The Door Controller Properties window displays the following:
e The settings for unlocking and re-locking
e The fime available before the door relocks or records alarm
events

To set door properties:

1. Inthe tree view, click on Networks.
The available networks are listed in the display area.

2. Select a network and expand a panel in the tree view.
Select a door to set its properties.

1
3. Click on the Editicon
The Door Controller Properties Window opens.
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1%Panel 1, Door 1 propetties ®

Daor lack [Output 1)

Description Auto relock.

|1\F’ane| 14Door On door monitor closed j

v REX enabled
[ First person delay on automatic unlock
[ Door output polarity is Normally Closed

¥ Marual door open enabled

Timers
Draor open time 0:04 == [min:zec)
Extended door open fime: 0:08 = [minsec)

Door held open

Dioor foiced open

— [min:zec]

1 BE

[min:sec]

H |

e e |

Figure 18: Door Properties window

The Door Properties window contains the following fields:

Field Description
Description Enter a name for the door.
REX enabled A Request to Exit unlocks the door for a user-defined

duration. Enable the checkbox to allow Requests to Exit
for this door. The door REX inputs locations depends on
panel configurations, they can be seen in the panel
properties window.

First person delay
on automatic
unlock

Sets the door's behavior during an automatic unlock
time zone. Enable the checkbox to require that during
the selected Time Zone the door remains unlocked only
after the first user opens it. The automatic unlock time
zone is selected in Panel Links Window by selecting the
output corresponding to that door. See Setting Panel
Links, page 53.

Door output
polarity is Normal
Closed

Enable this checkbox to ensure fail Safe door opening if
the Fail Safe door Lock Device power fails. Once
enabled, the door output relay will activate when the
door is closed and de-activate when door is open. In
this configuration, the Fail Safe lock device should be
wired to the door relay N.O (Normal Open) and COM
(Common) terminals.

Manual Door
Open Enabled

Enable this checkbox to allow operators to adjust the
door manually. See Controlling the Door Manually,
page 72.
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Field Description

Door open time  Set the duration for which the door stays unlocked.

Extended door  Set the duration for which the door stays unlocked for
open time users with Extended door open rights.

Door held open Set the duration for which the door can be held open
without raising an event.

Enable the checkbox to use this timer.

Door Forced Set the duration after which when the door is forced an
Open event occurs.

Enable the checkbox to use this timer.

4, Configure the door as required and click OK.

5.5 Configuring the Reader

A panel can be connected to two readers, or four readers when MD-D02
extension board is connected.
The reader properties window has two ftabs:

The General tab sets general operation settings for the reader
The Options tab sets access options for the reader

To configure a Reader:

1. Inthe tfree view, click on Networks.
The available networks are listed in the display area.

2. Select a network and expand a panel in the tree view.

Expand a door within the panel and select a reader to seft its
properties.
wh
Click on the Edit icon
The Reader Properties Window opens.

General Reader Operation Settings

The Reader Properties General tab displays:

The settings for how the reader will operate
The type of reader that is being used
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24 Panel 1'Reader 1 properties

Details-

Description Operation mode

General T Options

Twpe

2\Panel 1 \Reader 1 |Card only |

Direction: ® |n

Activation: [v OpenDoor [ Deduct User counter

FReadertvpe Keypad type

Secured (Card+FIN) time zone

|Never ﬂ

|W|egand 26 hits ﬂ |N0ne ﬂ

HID Corporate 1000 ”
‘Wiegand 32 bits

Wiegaretrtethoterreverrett
Wieg

o3 it I

“Wiegand 40 bits

“Wiegand 40 bits PCSC
Wiegand 64 bits -
Clock and Diata b digits b oK Cancel

Figure 19: Reader Properties General tab

The Reader Properties General tab contains the following fields:

Field Description
Description  Enfer the name of the reader.
Operation Select how the reader operates.
Mode Inactive: The reader is not in use.
Card Only: The reader will accept RFID cards only.
PIN Only: The reader will accept PIN inputs only.
Card or PIN: The reader will accept both cards and PIN
codes.
Desktop: The reader is inactive, but being used to
record new cards on the computer.
No Access Mode: The reader will not grant access to
any users.
Direction Select whether in the reader is allowing access into the area
or exit out of it.
Secured Select a time zone during which access should be granted
(Card+PIN) only after both the card and PIN are entered.
time zone The PIN must be entered within 10 seconds of the card.
Open Door Enable the checkbox to allow the reader to unlock the door.
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Field Description
Deduct User Enable the checkbox to record this entry against the user's
Counter entry allowance counter.
See General User Properties, page 45.
Reader type Select the data fransmission type for the reader hardware.
Keypad type Select the data fransmission type for the type of keypad
hardware.
Check Enable the checkbox to allow access to any user assigned

facility code
only

to a facility listed in the selected list of facilities.
The list of facilities is defined on the Options tab.

AYC-W6500
Biometric
Reader

Enable the checkbox to interface with the AYC-Wé6500
biometric reader and its PC application, BioTrax.

3. Configure the reader as required and click OK.

Reader Access Options

The Reader Properties Options tab displays:

Timed antipassback settings for the reader
Restricted site access settings

Reader propetties (]

General T

Timed antipassback

Automatic: antipazshack

Tirne

| Mever

|1 j 1 to 255 minutes]

Facility codes

j & Hard [alarm and access denied)

€ Soft [alarm only)

Add from list
Add manually
Remove

Ok | Cancel

Figure 20: Reader Properties Options tab

Page 37

AS-525 AxTrax Software Installation and User Guide



How to Set Up a Site

The Reader Properties window contains the following fields:

Field Description

Automatic Select the time zone in which timed anfipassback rules

Antipassback apply. To set Time Zones, see Defining Time Zones,
page 25.

Hard When hard antipassback is selected, an event is
generated and the door does not open.

Soft When soft antipassback is selected, the door opens but
an event is generated.

Time Set the number of minutes before a user can re-enter

using this reader.

Add from List

Click to add sites from a list.

The site list applies only when the Check site code only
checkbox on the General tab is enabled.

Add Manually Click to entfer asite code.
The site list applies only when the Check site code only
checkbox on the General tab is enabled.

Remove Remove the selected site from the list.

4. Configure the reader as required and click OK.

5.6 Configuring the Inputs

Every panel has four inputs. Using MD-IO84 adds another eight inputs (12
inputs total) and using MD-D02 adds four inputs (8 inputs total). Some
inputs are dedicated and some are general purpose inputs. The panel
properties window displays the settings for each input.

Input type is programmed individually no matter if it is a dedicated input
or general purpose input.

To configure an Input:
1. Inthe free view, click on Networks.

The available networks are listed in the display area.

2. Select a network and expand a panel in the tree view.

Select Inputs and select an input from the display area.

=

3. Click on the Edit icon
The Input Properties Window opens.
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Description

1'Panel 6 Input 1

|184Panel B\Door REX

| Mormally Open j

Activity start delay
00:00 =~ [min:sec)

Cancel

Figure 21: Input Properties window

The Panel Properties window contains the following fields:

Field

Description

Description

Enter a name for the input.

Type

Select the type of input to be monitored.

Normally Open/Close: An input either in an open
or close state.
Normally Open/Close 1 Resistor: An input in an
open, close or trouble state.

This option is only available for supervised inputs.

Normally Open/Close 2 Resistor: An inputin an
open, close or trouble state, with additional
checks for short-circuit and open-circuit
tampering.

This option is only available for supervised inputs.

For more information, please refer to the access control
panel hardware manual.

Activity start
delay

Set the delay time before this input becomes active.
Note that on normally open input, the delay starts once
the input contact is closed. On normally closed input,
the delay starts once the input contact opens.

4. Configure the input as required and click OK.

5.7 Creating Access Groups

An access group is a list of door readers and of time zones during which
each of those door readers are available for access. Every user is assigned

to an access group.

The Access Group window lists all the door readers defined in the
database and the time zones during which they can be accessed.
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To create an access group:
1. Expand the Groups element in the free view and select Access

Groups. Click the New icon - on the toolbar.
The Access Groups window opens.

Access group @

Description
|F|&D Access Group
Feader | Group time zone
8 H15Panel 1 \Reader 1(n) [Newer -
B 1%Panel 1 \Reader 2[0ut) Might Shift
'21 2Panel 2 \Reader 3In) Might Shift
g] 24Panel 2 \Reader 4(In) Mewver
4 Desk(in) Office Hours
g] I ain Entrance-Entry(ln] Ailways
ﬁi I ain Entrance-E sitfln) Always
| I arketting(n] Mewer
8 R4D Entyling Always
H R&D Esitin) Always
0K Cancel

Figure 22: Access Group window
The Access Group window contains the following fields:

Field Description
Description Enter a name for the access group.
Reader Lists every reader defined in the database.

Group time zone Select the time zone during which this reader should be
accessible.

2. Enfer a name for the access group and set time zones for readers as
required. Click OK.
The window closes and the display area displays the new access
group.

Access settings can be copy-and-pasted between access
groups. Right-click on a access groups and select Copy from the
shortcut menu. Right-click on a second access group and select
Paste from the shortcut menu.
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5.8 Creating Input Groups

Input groups are a collection of Inputs from panel or panels that can be

used in panel links to perform advanced operations.

To set an Input Group

1.

4
wputGrowp

Go to the Groups section in the Tree View pane, and expand the

view.

Select "Input groups," and right click the selection to create a

new group
or

Press the "New" icon to create a new Input group.

Expand the network(s) and panels.
Finally, check all relevant Inputs.

Description

|Input group 1

14Panel 1
Input 1 - 14Panel 14Daor RE=
Input 12 - 14Panel 150 oor Manitor
O Input 2 - 14Panel 145 pare Input 2
O Input 24, - 14Panel 145 pare Input 24
= Metwark 2 [2]
- 24Panel 1
Input 1 - 24Panel 14Daor REX
Input 12, - 24Panel 150 oor Manitor
O Input 2 - 24Panel 145 pare Input 2
O Input 24, - 24Panel 145 pare Input 24
[ 24Panel 2
[+ [ 24Panel 3

ak Cancel

Figure 23: Input Group Creation
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5.9 Creating Output Groups

Output groups are a collection of Outputs from panel or panels that can
be used in panel links to perform advanced operations, such as Elevator
control.

To set an Output Group

1. Go to the Groups section in the Tree View pane, and expand this
view.

2. Select "Output groups,” and right click the selection to create a
new group
or
Press the "New" icon to create new Output group.

3. Expand the Network(s) and panels.

4. Finally, check all relevant Outputs.

Description

|Dutput group 1

[1]
=[] 1%Panel 1
O Output 1 - 14Panel 15Daoor lack
O Output 14 - 14Panel 1T50utput 14
[ Output 2 - 14Panel 150utput 2
[ Output 24 - 14Panel 140utput 24,
= ] Metwark. 2 (2]
- 2¥Panel 1
O Output 1 - 24Panel 15Coor lock
Output 18 - 24Panel ThOutput 14
Output 2 - 24Panel 150utput 2
O Output 24 - 24Panel 1T50utput 24
+--[ 24Panel 2
#-[] 24Panel 3

ok, Cancel

Figure 24: Output Group Creation
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5.10 Defining Cards

The AxTrax database maintains a list of every user card or PIN that has
been assigned. The Add Cards window defines:

The type of reader needed to read the card
The number of cards to create
If users should be created in the database for each new card

To Define Cards:

1. Select Cards in the free view.

Click the New icon o on the toolbar.
The Add Cards window opens.

Add Cards &3]

Manual 1 1MD-08

Reader type
[Wiegand 26 bits =
Sequential cards

Cards quantity

[

Startfram(0 to 65.535)

Facility code (0to 255)

User Number started from

P

[~ MNewUsers

Cancel

Figure 25: Add Cards- Manual tab
The Add Cards — Manual tab contains the following fields:

Field Description

Reader Type Select the type of reader appropriate for these cards.

Cards quantity Enter the number of cards to add.

Start from Enter the card number for the first card in the set.

Facility code Enter the site code for these cards.
This field is not available for all reader types.

New Users Enable this checkbox to create a new user in the
database for each new card.
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2.

Field

Description

User Number
started from

checkbox is enabled.

Enter the user number for the first user in the set.
This field is only available when the New Users

A maximum of 1000 users can be generated at one

time.

Set fields as required and click Add.

A dialog reports that the operation has been completed.

Enrolling cards using MD-08
This option is available for users with the MD-08 unit on-board.

To Define MD-08:

1.

3.
1.

Click the New icon

Select Cards in the tree view.

e on the toolbar.

The Add Cards window opens (see Figure 25).

Click the MD-08 tab.

The MD-08 tab is displayed.

.Gd Cards @

M anual T MD-D8

Reader lype Com Port

|'wisgand 26 bits = =
| Facility Code | Card Mumber | Select all

Select none

User Mumber started from:

e

[T MNew Users

Add ‘ Cancel

Figure 26: Add Cards- MD-08 tab

Select your Reader type, and then Com Port.
Click Add.
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5.11 Defining Departments, Users and Visitors

Every user is grouped within a department. The AxTrax AS-525 stores
contact details for each user, associated card details and user access
rights.

The User Properties window has four tabs:

General tab displays identification and conftrol information

Codes tab displays information about cards associated with the user
Details tab records user contact details

User Fields tab stores user-defined data

To create departments:
1. Select the Departments\Users element in the free view.

2. To create a new Department, click the New icon . on the toolbar.
The Departments dialog appears.

Diepartment

Description

Departrment 3

0K Cancel

Figure 27: Department dialog
3. Enfer a name for the department and click OK.

To create users:

1. Expand the Departments\Users element and select a Department for
the new user.

2. Click the New icon d on the toolbar.
The User Properties window opens.

General User Properties

The General tab displays:

User identification information
User validity setftings
Access rights for the user
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General T Codes ]/ Details T Uszer fields
Phota
First name Middle name
I
Last name Lser number
Department Arcess group
|General ﬂ |Master ﬂ
A alid datedtime
Time getting not supparted in AC-215.
[ Uil
Fram
| 0140342009 | | |
Add
120 o —

Counter

Color [~ Enabled
Location 1l B e G 0 j (1 to 1000)

Rights Links
il lected Output
[~ Antipassback Immunity [~ Access Granted zommand ki
| Maore j
— Extended door open [~ Access Denied command [ Handicapped

tirme:

1 Mew User | QK ‘ Cancel ‘

Figure 28: User Properties Window

The General tab contains the following fields:

Field Description

Add/Remove Click to add a photo of the user, or to remove
an existing photo. Note that the selected photo
aspect ratio should be 1.25 H x 1.00 L otherwise
the photo may be distorted.

First name Enter the user's first name.

Middle name Enter the user's middle name.

Last name Enter the user's last name.

User number Enter a unique user number to identify the user.
Department Select the user's department.

Access group Select the user's access group.
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Field Description

Select color Click to select which color to use to highlight this
user when access events generated by that
user.
User highlighting must be activated in Tools >
Options > General tab.

Location Click to display a log of doors accessed by this

user.

Valid date/time from

Enter the date/time from which the user's access
rights begin.

Valid date/time until
(checkbox)

Enable the checkbox to set the date/time on
which the user's access rights end.

Valid date/time until
(field)

Enter the date/time on which the user's access
rights end.

This field is only available when the checkbox
has been enabled.

Enabled Enable the checkbox to set an access rights
countdown counter for this user.
When the counter reaches zero, the user's
access rights end.

Test Click to check the current state of the user's

countdown counter.

Set new counter
(checkbox)

Enable the checkbox to set a new countdown
counter value for this user.

Set new counter (field)

Enter a new countdown counter value for this
user.

This field is only enabled when the Set new
counter checkbox has been enabled.

Rights  Antipassback
immunity

Enable the checkbox to override any
antipassback restrictions for this user.

Extended door

Enable the checkbox to entitle this user to an

open time extended unlocked door duration.
The extended duration is set for each door. See
Setting Door Properties, page 33.
Links Access Enable the checkbox to activate a user-defined
Granted set of inputs or outputs for this user.
command

The operations are set in the Links window. See
Setting Panel Links, page 53.
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Field Description
Access Enable the checkbox to activate a user-defined
Denied set of inputs or outputs for this user.
command  The operations are set in the Links window. See

Setting Panel Links, page 53.

User Select an output group for this user.
selected  1he outputs will be friggered every time the user
Output accesses a door, as specified in the Links
group window. See Setting Panel Links, page 53.
Handicapp Enable the checkbox to activate a dedicated
ed check- output ashort time after the door is unlocked.
box

The outputs are set in the Links window. See
Setting Panel Links, page 53.

Associated Cards and Codes

The Codes tab displays:

The card codes assigned to this user (up to 16 cards)

The PIN code assigned to this user

Biometric fingerprint templates for this user, only valid when using
Rosslare’s AYC-W6500 Biometric reader and its corresponding PC

application
Beneral Tdes 1 Detals T Use fields

Cards
[ SteCode | Card Number I Status e from st

=H 0000000010 Active

Acd manually
Fremove

PIN Cade

Number of digits Code

4 = 1234 Auta PIN
Fingerpiint

Fingerprints: 0
4] 4510 > pl New User ‘ ok ‘ Cancel

Figure 29: Users General tab

The Codes tab contains the following fields:

Field

Description

Site Code

The site code assigned to this card.
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Field

Description

Card Number

The unique number of this card.

Status

Select the status of the card. Inactive cards cannot
gain access to the facility.

Add from list

Click fo add a new card.
All cards within the user's specified site code are listed.

Add Manually

Click to create new cards from the Add Cards window.
For more information, see, page 43.

Number of digits Select the length of the PIN for this user.

Code Enter a PIN.

Auto PIN Click to automatically generate a random PIN.
Fingerprint Specifies if the user has recorded fingerprint templates.

For use with the AYC-W6500 Biometric Reader and its
corresponding PC application.

User Contact Details

The Details tab records contact and identification details about the user.

General T Codes T Details User fields
Telephons Home telephons
|18 83 456 7oz |718 34 567 3295
Hobie Car regisralion
[073363 3459 |23BD 2387
Fax Title
[ |Prafessar
Emal Employment date:
[iahnsrmith@noone co.not [o1/04/2010 ~|
Address Notes
Flat 1 Keeps losing his cards|
1st Steet
Onevile
1111
Details
14| 4510 [ 3] Mew User ‘ 0K ‘ Cancel |

Figure 30: Details tab

The Details tab contains the following fields:

Field Description
Telephone Enter an office telephone number for the user.
Mobile Enter a cell phone number for the user.
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Field Description

Fax Enter a fax number for the user.
Email Enter an email address for the user.
Address Enter a postal address for the user.

Home telephone Enfer a home telephone number for the user.

Carregistration  Enter the user's license plate number.

Title Enter the user's tifle (e.g. "Mr.").

Employment Date Enter the date the user joined the firm.

Notes Enter any additional information.

Details Click to open the user's additional details folder.

User Defined Data

The User Fields tab can be used to store any information required by the
system operator.

General i Codes I Detais | Userfields
User Defined
Use Defined
User Defined
1 -
v Lser Defined
| 4 Newser | o | Coredl |

Figure 31: User Fields tab

User fields are defined in Tools > Options > User Fields tab. See User
Defined Fields, page 88.
3. Enter details for the user and click OK.

4. Click "New User" from within user tab to add new users.
5. The window closes and the display area displays the user.

To create visitors:

1. Expand the Departments\Visitors element and select Visitors fo add
new visitors.
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2. Click the New icon d on the toolbar.
The Visitor Properties window opens.

=

5.12 Creating Access Areas and Global Antipassback
Rules

A large site can be divided into several smaller and more manageable
access areas. Reports can be produced individually for each area.

In addition, global Antipassback rules can be applied for each access
area. When global Antipassback rules are in force, a user cannot re-enter
an access area until they have left it.

i'm Global Antipassback functiondlity is only enforced when the

AxTrax AS-525 is connected and monitoring the entire access
control system.
Use the Access Area window to add entry and exit door readers to and
from an area within the facility.

For information on the Codes, Details, and User Fields tabs, please
refer to the To Create Users section above.

To create a new access area:

1. Expand Access Area in the free view and select the parent area
within which to add the new access area.

Click the New icon d on the toolbar.
The Access Area window opens.
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Access area
Description
Buiding Entrance
Enler o area Fieaders st Exit rom erea
i 5\Panel 1 \Readr 1 Bl 5\Panel 2 \Rleader 1 i 5\Panel 1 \Reader 3
i 5\Pznel 1 \Reader 2 8l 5\Panel 2 \Rleader 2 # 5\Panel 1 \Reader ¢
Bl 6\Panel 1 \Fleader 1
Bl 6\Panel 1\Fleader 2
i 6\Parel 2 \Reader 1
8 6\Panel 2 \Fleader 2
[i13 Cancel

Figure 32: Access Area window
The Access Area window contains the following fields:

Field Description

Description Enter a description for the access area.

Enter to area Lists the entry readers into this access area.

Exit from area Lists the exit readers out of this access area.

</> Click fo add and remove readers from the Enter to

Area and Exit from Area lists.

2. Enter a name for the access area and select entry and exit readers.
Click OK.
The window closes and new access area appears in the display area.
3. Select Global Anfipassback in the tree view and click the New icon

on the toolbar.
The Global Antipassback dialog appears.
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Global antipassback iz active only when Veritrax server is unning and
connecting to panels.

Drescription
|Main Offices Antipazsback

Access areas

| Main Office Area j
Automatic antipassback
| Office Hours j

¢ Hard [alarm and access denied]

¥ Soft [alarm anly]

1] | Cancel

Figure 33: Global Antipassback dialog box

4, Enter a description for the Anfipassback rule, select the access area
and time zone for which it applies. Select Hard or Soft Antfipassback.

5. Click OK.

The dialog closes and the global Anfipassback rule is shown in the
display area.

i'm] Global Antipassback will cause Antipassback event only on
"Enter" readers to the defined "Area".

To implement Antipassback on Exit readers as well, it is necessary
to define a new area with opposite reader directions:

Readers defined "Enter" in first area need to be defined again in
the new Area as "Exit" readers, and "Exit" readers in first "Area”
should be defined "Enter" readers in second "Area’.

5.13 Setting Panel Links

Panel Links are rules for how the system should behave when events occur
in the access control panel. The Links window displays:

An event on a panel and the panel element to which the link
response applies

The required input or oufput response

Any alarm message to display on the AxTrax AS-525 computer

To create a panel link:

1. Inthe tree view, click on Networks.
The available networks are listed in the display area.

2. Select a network and expand a panel in the tree view.
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Select Panel Links and select a link from the display area.
il

Click on the Edit icon

The Links Window opens.

Links 3]
Source Type Destination Type
}Inpul Ll ]None L]
Source Destination
1Inpul1 -2\Panel 14\Door BEX L] |Nnne L]
Event Operation
]Comad Closed LJ |N0ne ﬂ
Ewvent Description Time (mm:ss)
‘Cunlad Closed | B —i
[¥ Enabled Time Zone
[v Generate Alarm ]Always L]

Alarm handler

Alarm Message
Select color

[ Sound

SelectWave Audiofile
|C.\WINDOWS\Med\a\start.wav

Sound now

QK Cancel
Figure 34: Links window
The Links window contains the following fields:
Field Description
Source Type Select the panel element type which raises the event.
Source Select the panel element which raises the event.
Up to 8 links can be added for each source in AC-225
and AC-525.

Up to 2 links can be added for each source in AC-215.

Event Select the event.

Event Description Enter a description for the event.

Enabled Enable the checkbox to activate this link rule.
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Field

Description

Generate Alarm

Enable the checkbox to generate an alarm condition
when the selected event occurs.

Destination Type

Select the panel element type that responds to the
event.

Destination Select the panel element that responds to the event.

Operation Select the operation for the destination element to
perform.

Time Enter the duration for which this operation should
apply. This box is only available when a time-bound
operation is selected.

Time Zone Select the time zone during which this link rule applies.

Alarm Message

Enter a message to be displayed as an on-screen
alarm when the selected event occurs.

This box is only available when the Generate Alarm
checkbox has been enabled.

Select Color

Click to select a color for the alarm message.

This box is only available when the Generate Alarm
checkbox has been enabled.

Sound check-box Click to select Sound for Alarm; operable when

Generate Alarm check-box is checked.

Browse Browse files for the sound *.wawv file you want for the
Generated Alarm to sound.

Sound Now Click Sound Now button to generate the selected

button sound.

I'm Numerous events and links are defined in Panel Links. The

Operators must avoid conflicts or illogical definitions. Not all event
sources that appear in Panel Links are enabled in the panel, and
the Operator should verify them. Test the Link condition
operations after making any changes in the Link definitions.

5.14 Creating Elevator Control

Elevator control can be created in the following four simple steps.

Step One:

Assign a reader to the elevator control.
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Normally, a reader is associated with a door. For elevator control, a
selected reader should be associated with several outputs (floors). In the
reader Properties window, deselect the Open Door check box. See
Setting Door Properties section on page 33.

Step Two:
Create output groups.

Every output group represents a floor or several floors. To create an
output group, see Creating Output Groups on page 42.

—

i

Step Three:
Create panel link.

(Only one panel link is required.)

Figure 35 shows the Panel Link confi%uro’rion.

When creating an output group for the elevator control, the
selection only applies to outputs from the same panel.

Source Type Destination Type
[Reader - [User's Dutput Group ~|
Souice Destination
[Reader 1 - 2\Panel 1 \Reader 1 = [User's Dutput Graup -~
Event Operation
[Output Group selected by user | [ Dutput Timer |
Event Description Time [mm:ss]
[Elevator control [00:04 —
¥ Enabled TimoEmn0
= [ rays -~
r
Select Wave Audio file
oK. Cancel

Figure 35: Panel Link Configuration

Step Four:

Associate users with elevator control rights.

Each user can be associated with the relevant access group to allow that
user access to specific floors, as needed.

In the General tab of the User window, associate a user with output
groups. See General User Properties, on page 45.
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5.15 Creating Status Maps

The Status Map displays the status of every door, input, output,
antipassback rules and alarms in the facility on user-selected floor plans.

To set-up a Status Map:
1. Inthe tree view, click on Events, then click Status Map and click on

the New Element icon

A new map element appears in the tree view.

Right-click on the new map element. A shortcut menu appears.
Select the Picture option. The Select Image File window opens.

i'm To change map image and/or to add objects on the map, you

must press the Pause key 1 (see Toolbar, page 19), after which
the option fo right click the map name on the tree view will be
enabled.

4. Select a graphic file for the Status Map background.

The file is shown in the display area in one of the following formats:
ipg. gif or bmp.

an Axtrax AS-525 Access Control System
Fie Tools Help

ae :
System
i 97 Natine Properties -
|
F- B Newwork 1| Ficture
w0 Time zones it
+ 3 Groups
w1 Access aeas
2 Global artipassback
Cardes

+ i Depatmertstlsers

] Holidays

' Operatars

w2 Repoits

- m | H

5 Server admiristrator 25042007 0329

Figure 36: Status Map with Image
5. Ensure that the Status Map toolbar is showing the "offline mode" icon

| ]
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Click on Networks and right-click on a door, reader, input, oufput,
panel or another status map that should be displayed as an object
on the status map.

Select Add to Map from the shortcut menu.

The object appears on the status map, and can be dragged to its
correct position.

] Axtrax A5-525 Access Control System 9=
File Tools Help
o B s |4 & w » ®©

Events

0 Panels

I tocess r—1\PaneI 1\Door
=T Status Map [

T Main Floor

) System
73 Networks
-84 Network 1(1)
£ 14Panel 1
= B 1WPanel2 L&
1 Penel Links
= 1%Panel 2Door 1 ?
8 14Panel 2 \Read

B

E Ouputs | Edt

" Inputs Addto map
o B 1Panel 3
_3 Tine zones

soministrator 25412007 [0348

Figure 37: Status Map with Door

6. Right-click on a map object to set its properties, and select Show on
Map from the shortcut menu.

The Show on Map window opens.

show on Map - 1'Panel 1'Door

Status

" By Door Maonitor

f* By Door Output

oK Cancel

Figure 38: Show on Map window
7. Enable the Status checkbox to display the objects state on the status
map.
For a door's Show on Map properties, select:
By Door Monitor- show the door's open state based on its physical
position.

By Door Output- show the door's open state based in the status of its
lock.
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8. Repeat step 5-7 until all objects are shown on the status map, as
required.

Repeats steps 1-7 to setup additional status maps.

i'm] Status map icons can also be added to other status maps,
indicating where the two map areas meet.

5.16 Setting Door Forced

Door Forced occurs when a controlled door opens illegally when the door
relay output is not activated. This may occur if someone opens a door
without inputting a valid code or using a Door REX button.

In order to detect a Door Forced condition, the door must be equipped
with a door contact connected to the Monitor to the Monitor Input of the
relevant door.

When Door Forced is enabled, the system can generate a Door Forced
event, which can be used to generate an alarm or to toggle an output.

1 Panel 2\.Door 1 properties

Door lock [Output 1]

Description Auta relock
|‘I\F'ane| 2\Doar 1 On door monitar closed j

Jv RE enabled
[ First person delap on automatic unlock
™ Droor output palarity is Mormally Closed

¥ Manual door open enabled

Timers
Droor open time 0:04 == [minzec]
Extended door open time 0:08 = [mimzec]
Door held open " 0:30 == [mirsec)
Dioor forced open v 0:00 —= [mircsec)
oK | Cancel

Figure 39: Door Properties

To Set Door Forced

1) On the AxTrax Tree menu, select Network>Panel>Door.
The Door Properties window opens.
2) Check the Door Forced checkbox.
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3) Enfer a delay (if required) in Minutes and Seconds. Usually, delays
are nor required since Door Forced is detected immediately.
This setting allows a "Door Forced" event to be generated. The
event can then be used to generate a system alarm, or to
activate an output. All of these possibilities may be configured in
the "Links" window.

4) On the AxTrax Tree menu, select Network>Panel>Panel links>
"New" command button.
The Links window opens, followed by the Door Properties window.

5) Define the location and results of the Door Forced conditions:
In "Source Type" and "Source" select the Door on which Door
Forced should occur.

In "Event" select "Door Forced Open".

In "Destination”" and "Destination Type," select the operation that
Door Forced should frigger (including "None" if applicable).

6) To generate an alarm condition, enable the "Alarm" checkbox
and define the alarm details as described above.

Source Type Destination Type
|Door j |Dulputs j
Source Destination
[Door 1 - 14Panel 2\Door 1 =~ [ Output 14 - 1\Panel 210utput 14 |
Event Dperation
|Door 1 forced open j |Dulput Timer j
Event Description Time [mm:ss)
[Docr 1 forced apen [o0:10 -
Iv Enabled Time Zore
IV Generate Alaim |A\wa51s ﬂ
Blarm handler

Alarm Message

D oor Forced Condiion Jsfaiagor

v Sound

Select wave Audio file
|E SafIND DY S ediabingout. way

Sound nov Erowse

Ok ‘ Caneel ‘

Figure 40: Door Forced Settings
5.17 Setting Door Held Open

Door Held Open is a condition where the confrolled door remains open
longer than a predefined period. This is useful for detecting a condition in
which a door is not closed condition after it has been validly opened. The
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Door Held Open condition may occur if someone blocks the door for free
passage.

In order to detect the Door Forced condition, the door must be equipped
with a Door contact, connected to the Monitor input of the relevant door.

When Door Held Open is enabled, the system can generate a Door Held
Open event, which can generate an alarm or can toggle some oufput.

1'Panel 2\ Door 1 properties

Doar lock [Dutput 1}

Drescription Auto relock
|'I “Panel 2\Door 1 Orn door monitor clozed j

v REX enabled
[ First perzon delay on automatic unlock
[ Door cutput polarity is Normally Closed

W Manual door open enabled

Timers
Daor open time 0:04 == [min:zec]
Extended door open time 0:08 = [min:sec)
Door held open i~ 0:30 = ([minsec)
Diaar forced open = 000 = [min:sec)
ok | Cancel

Figure 41: Door Properties

To Set Door Held Open

1)
2)
3)
4)

5)

6)

On the AxTrax Tree menu, select Network>Panel>Door.

The Door Properties window opens.

Enable the "Door Held Open" checkbox.

Enter the required delay in Minutes and Seconds. (Normally, 30
seconds is a sufficient delay.

This setting generates a "Door Held Open" event, which can be
used to generate a system alarm, or to activate an output.

These possibilities can be configured in the "Links" window.

On the AxTrax Tree menu, select Network>Panel>Panel links>
"New" command button.

The Links window opens, followed by the Door Properties window.
Define the location and results of the Door Held Open conditions:
In "Source Type" and "Source" select the Door on which Door Held
Open occurs.

In "Event" select "Door Held Open".
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In "Destination”" and "Destination Type" select the operation that
Door Held Open will trigger (including "None" if applicable.

7) To generate an alarm condition, enable the "Alarm" checkbox
and define the alarm details as described above.

Source Type Destination Type

[Door | | Sounders |
Source Destination

[Door 2 - 14Panel 24D oo 2 ~| | Chime ~|
Event Opstation

[Door 2 held open =l |Sounder On |
Event Desciiption Time (mm:ss)

[Door 2 held open [ =1

W Enabled Time Zone

[V Generate Alam | oy ~l

Alaim handler
Alarm Message

Door Held Open. Make sure to closs the daor. Default color

¥ Sound
Select Wave Audio file
|E Nl IND DS WM ediahding way

Sourd now I Browss
0K Cancel
Figure 42: Door Held Open Settings

5.18 Door Interlock

Door Interlock, sometimes referred as Mantrap, prevents two or more
related doors from opening at the same time. It may be useful for the
entry holes of Clean Rooms or in other facilities with two exit doors. It
should only be possible to open one door at a time with a valid user code.

Axtrax features a dedicated mechanism to define Interlock for 2, 3, or 4
doors, as long as they are located on the same access control panel.
Interlock cannot be used in panels that support a single door.

To enable Interlock, related doors must be equipped with a door position
sensor, connected to the Door Monitor input of the relevant doors. Door
Interlock only restricts user entry through readers or keypads. The use of
REX button or Links settings should not be used to activate doors, which
are noft limited by Interlock.

Doors are considered open when either the Door Monitor or the Door
Relay are opened, and it should not be possible to open any other
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related door with user codes. If an attempt is made to open another door,
an "Access denied-Door inferlock” event is generated.

Setting Door Interlock

In a typical Interlock application with a 2Doors/4Reader panel controlling
entry and exit to a restricted area, the doors and readers may be located
as follows:

Doorl/Readerl - Entry from outside info Man Trap room
Doorl/Reader2 — Exit from Man Trap room to outside
Door2/Reader3 - Entry from Man Trap room into restricted area
Door2/Reader4 — Exit from restricted area into Man Trap room

Restricted area

Entry and Exit Room room

Readerl I | Reader3 I

Reader2
L AL

Doorl

Door2

Figure 43: Door Interlock Diagram
Axtrax Door Inferlock Setting:

1)  Edit "Panel screen >> Options tab".
2) In"Door Interlock" select "Enabled" checkbox.
3) Enable at least two door checkboxes.
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Panel properties 5]
G Y Gptions

Door anipassback

Automalic anijpassback  Hard (alaim and access deried]

Never T ¢ sotfalamoriy)

1N Rieaders OUT Readers

I~ 1\Panel 1 \Rieader 1
[~ 1\Panel 1 \Reader 2
[~ 1\Panel 1\Resder 3

[~ 1\Panel 1 \Reader 4

Everts fiter

Select

o Intetlack.

¥ Enabled
¥ Door 1 ¥ Door 3

v Door2 v Dasr &

o o el

Figure 44: Setting Door Interlock
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6. ViTrax Video Integration

Utilizing camera’s on your AC-525 panel is done using the following Steps:

Step Action Section

0 Connecting to ViTrax Server. See Connecting to ViTrax
Server, page 65.

e Adding a Camera to AC-525  Adding a Camera to AC-525

panel. panel, page 65.
e Using Panel Links. See Setting Panel Links, page
53.
e Viewing Recorded Events. See Viewing Recorded
events, page 69.

6.1 Connecting to ViTrax Server

Define the ViTrax Server database with which the AS-525 AxTrax Software
communicates.

To Connect to ViTrax Server:

1. When the ViTrax Server is running, click File/ViTrax Server.
The ViTrax Servers window is displayed.

New — 9 & =

%ess | User Name | Auto connect ‘ Status |
Edit
Delete

Figure 45: ViTrax Servers

2. Click the New icon o on the toolbar.
The Server ViTrax window is displayed
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Server YiTrax disconnected =)

WiTrax IP Adress
|\oca\hasl

WiTrax User Name
|adm\n

WiTran Password

[ Connect

v Auto connect on Start oK. ‘

Cancel

Figure 46: Server ViTrax window

3. Inthe ViTrax IP Address field, type in either Local host or other IP
address name.

4. Inthe ViTrax User Name, type in Username
5. Inthe ViTrax Password, type in Password

The Password typed must resemble the non-default password for

I' ] the server.

6. Click Auto connect on Start checkbox.
7. Click Connect.

8. Click OK.
The message “ViTrax Server Connected” is displayed.

=

The ViTrax server now appears in the ViTrax Servers window list
(see Figure 45).

¥iTrax Servers @
a @ =
1P Adress [ User Name [ Auto connect [ Status [
localhost admin Yes Connected

T Case

Figure 47: ViTrax Server list
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6.2 Adding a Camera to AC-525 panel

Defining communication of AC-525 cameras to the ViTrax Server, is done
physically between the camera and the AC-525 panel, see AC-525
Installation Manual.

The cameras available on this network are displayed when clicking the
Network on the tree. When clicking the icon the camera list is displayed.
Expand the free to see which cameras are connected to which panels.

To configure a camera to the network:

Configure the Network as seen in Section 5.2.
Once the camera is physically installed, the system reads the camera
on the network and displays it on the tree.

T
@ AxTrax AS-525 Access Control System ‘__ “ﬂyl
e Tk teb i
=4 A Tra ATD0G B & |4 e i
f < Events b - - T
oo [ Psripien [ Hhrner | T [ A [speet | s [
n Q:éNgmrmﬂ) EQNPMWM 1 Serial el RN Nisahtad
- E) Natsark 2 ) ZiNetvork2 2 TCRiP TH2.768.10.173/2004 W Ok
1 2\Panel1
(0 Tite rnes
w88 Groups

- Arcass areas

7] Global antipasshack
@ Cards

-4 Departmentsilsers
) Holidays

g Operators

-5 Reports

Figure 48: Camera icon

To view the camera list:

Click the Camera icon.
The Camera list window is displayed.
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Description [ 1P Address [ Chanel [ Vitrax Server [
ack25 hitp://192.16810179 A Iocalhost

Figure 49: Camera icon

6.3 Conditioned Recording via Panel Links

You can select the source, destination, and period of recordings
using Conditioned Recording sequences, programmed via the Panel
Links screen.

To create a panel link:

1. Inthe free view, click on Networks.
The available networks are listed in the display area.

2. Select a network and expand a panel in the free view.

Select Panel Links and select a link from the display area.
=

Click on the Edit icon

The Links Window opens.
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Links

Source Type Destination Type
[input | [Local recording =]
Source Destination
[input1 - 24Panel 14Doar REX ~| [Camera A mamentary recarding B
Event Operation
[contact Closed =
Event Description Time (nmss)
[Contact Closed [ —
[¥" Enabled Time Zone
[~ Generate Alam [Ahways ~]
-
SelectWave Audio file
ok Cancel

Figure 50: Local Recording
3. In Destination Type drop-down list, select Local recording.

4. In Destination drop-down list, select a camera: momentarily recording
or pre event recording, and then click OK.

6.4 Viewing Recorded events

In the Camera Properties window you can view live streaming and edit
various camera properties.

To access Camera Properties:

1. Double-click Camera <name> in the Tree View.

= AT AxTrax AS-525
+ < Ewents
=21 Netwarks
+ 21 Network 1 (1)
=31 Network 2 (2)
=W 2\Fanel1
11 PanelLinks
+-- 2yPanel 14Door
[ Outputs
A Inputs
[ 2Panel 1\Camera A acB2s |

Figure 51: Camera Properties

2. Double-click Camera <name> in the Tree View.
The Camera Properties window is displayed.
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Camera Properies

Dessription

2\Panel 1\Camera & ac-525

Froperties
FE Archive
Local frchive

Audio from Camera-

¥ Enabled

Wolume:

Audio to Camers
¥ Enatled

Microphans Device

i SoundM! Digal udio
Status: Connected o —

®

Figure 52: Camera Properties window

The Camera Properties window includes the following:

Field

Description

Properties

Camera hardware properties

PC Archive

Streams saved in PC

Local Archive Streams saved in USB-key
Audio from Enable the option and select volume
Camera -
Audio fo Enable the option and select Microphone Device
Camera-
3. Click OK.

I'm] ViTrax Server must be running to view recordings.

For more information on camera properties, see ViTrax Software Manual.

To access Live Video:

1.

Right-click Camera <name> in the Tree View.
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=B Networks
[+ 24 Netwark 1(1)
= Network 2 (2)

= ] 2\Panel 1
11 PanelLinks
@ 24Panel 14Doar

£ Outputs

C] Inputs

B 87 Panel 14Camera & ac-525
View
Edit
Delete

Figure 53: View Live Camera

2. In the Right-click menu, select View.
The Live Video Streaming window is displayed.

Live Yideo - 1Panel 1, Camera B AC-525 [B] {192.168.20.153)

| |
e n ;@ﬂl Statug: Connected

[audio to Camera]

Figure 54: Live Video Streaming

The Live Video Streaming window includes the following:

Icon Name Description
- I Recording Saving streams to archive, page 19.
| = I Stop Stops Recording to the archive.

cﬂﬂul Audio to Camera Speak from PC microphone by calling to
—_ Panel Ram

3. Click Cancel to close.
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7. Manual Operation

In addition to the AxTrax AS-525's automated monitoring and conftrol of
the access control network, it is also possible to control the network

directly.

7.1 Controlling the Door Manually

The Door Manual Operation window allows an operator to open or close
a selected group of doors directly.

To manually open or close a door:

1. Click the Open Door Manually icon

il

on the toolbar.

The Door Manual Operation window opens.

Door manual operation

Options

& Open momentarily (closed by timer)

1. Select the door operation by the option buttons.
2. Check the door for manual operation.
3. Click "Apply’ to sent the operation

" Close output and return to default mode

" Dpen pemanently (closed by 'Close output and return to default mode']

0:04 — [min:sec)

| Location

Description Status ~ Select all
Netwark 2524Panel 1 A\Panel 1\Door Claose =
Metwork 1%14Panel 6 T4Panel B4Door 1 Cloze g
&lect none

[F Metwork 141%Panel 6 14Panel Do 2 Close

Netwark 1514Panel § 14Panel 55D oor Clase

Metwork 1%14Panel 4 T4Panel 44D oor 1 Cloze
[ Metwork 141%Panel 4 14Panel 4Doo 2 Close v

>
Apply ‘ Cancel |

Figure 55: Door Manual Operation window

The operator can sort the listed panels/doors in regular or reverse
order by clicking the column header with the left mouse button.

2. Select an option:

Open momentarily- All selected doors are opened for the time set in

the timer box.

Open permanently- All selected doors are opened.
Close output- Close the selected doors and return control to the

AxTrax AS-525.

applies.

Enable the checkboxes to select to which doors the operation
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Click Apply to perform the operation.

Door Manual Operation can only control doors that have been set
as Manual Door Open Enabled in the Door Properties window. See
Setting Door Properties, page 33.

7.2 Changing the Reader Mode

The Manual Reader Operations window allows an operator to change the
operation mode of areader.
Readers have six possible operation modes:

Inactive: The reader is not in use.

Card Only: The reader will accept cards only.

PIN Only: The reader will accept PIN inputs only.

Card or PIN: The reader will accept both cards and PINs.

Desktop: The reader is inactive, but can record new cards for the
AxTrax AS-525 database.

No Access Mode: The reader will not grant access to users.

Card + PIN: The reader requires both a card and then a PIN. The PIN
must be entered within 10 seconds of the card.

To manually change the reader mode:

1. Expand the Networks element on the free view and expand a
selected network.

Select a panel in the free view and click the Change Reader Mode

. |
icon .
The Manual Reader Operations window opens.
Options
{~ Change operation mods

&+ Default

| Description ‘
T\Panel 1 \Reader 1

T\Panel 1 \Reader 2
Select none
T\Panel 1 \Reader 3

1WPanel 1 \Reader 4

EEEA

Apply | Cancel ‘

Figure 56: Manual Reader Operations Window
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Select an opftion:

Change operation mode permanently- Resets all selected readers to
the selected operation mode.

Change operation mode until Card+PIN starts- Resets all selected
readers to the selected operation mode until they enter a secured
fime zone.

In the secured time zone, the operation mode switches to Card +
PIN.

Default- Returns control of the readers to the system.

Enable the checkboxes to select to which readers the operation

applies.
Click Apply to perform the operation.

i'm For more information on secured (Card + PIN) time zones, see

General Reader Operation Settings, page 35.

7.3 Controlling Outputs Manually

The Manual Output Operation window allows an operator to open or
close a selected group of outputs on a panel directly.

To manually open or close an output:

1.

Expand the Networks element on the tree view and expand a
selected network.

Select a panel in the free view, and then click the

Change Output Operation icon l:

Manual Dutput operation E

Optians
+ Dpen mamentarily [closed by timer] 0:04 == [minzec)

(" Open permanently [closed by Close output and return to default made]

{" Close output and return to default mode

| D escription
Output 1-14Panel 24Doar 1

Output 14-1\Panel 230utput 14
Output 2-14Panel 2\Door 2 Select none

Output 28-1\Panel 240utput 24,

HEEA

Apply ‘ Cancel |

Figure 57: Manual Output Operation window
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2. Select an option:

Open momentarily- Opens all selected outputs for the time set in the
fimer box.
Open permanently- Opens all selected outputs.
Close output and return to default mode- Closes the selected outputs
and returns confrol o the AxTrax AS-525.

3. Enable the checkboxes to select to which outputs the operation
applies.

4. Click Apply to perform the operation.
7.4 Manually Disarming Inputs

The Manual Input Operation window allows an operator to disarm a
selected group of inputs on a panel directly.

Armed input means input is active; Disarmed input is inactive and will not
frigger any operation or alarms.

To manually disarm or re-arm an input:

1.  Expand the Networks element on the tree view and expand a
selected network. Select a panel in the tree view and click the

:j .

Change Input Operation icon

Manual Input operation @
Optlions

" Input permanently disarmed

& Arm input and return to default mode:

‘ Description | i Selectal

Input 1 - 15Panel 24Doar 1 REXy
Input 14-14Panel 2\0aor 1 Manitar c

elect none
Input 2-14Panel 24000 2 REX

Input 2&-1%Panel 24Daor 2 Manitar

EEERE

Bpply ‘ Cancel ‘

Figure 58: Manual Input Operation window
2. Select an option:

Input permanently disarmed- Deactivates all selected inputs.
Arm input and return to default mode- Reactivates the selected
inputs and returns control to the AxTrax AS-525.
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Enable the checkboxes to select to which inputs the operation
applies.

Click Apply to perform the operation.
7.5 Testing the Siren

3.

The Manual Siren Operation window allows an operator to test the siren for
a selected panel.

To test the siren:
1.

Expand the Networks element on the free view and expand a
selected network.

Select a panel in the free view, and then click the Siren Operation

icons.
Options
f+ i0pen momentarily [closed by timer} 0:04 == [mirzec]
" Cloze siren and returt to default mode
Apply Cancel

Figure 59: Manual Siren Operations window
2. Select an option:

Open momentarily- Sounds the siren for the time set in the timer box.

Close siren and return to default mode- Silences the siren and returns
control o the AxTrax AS-525.

Click Apply to perform the operation.
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The AxTrax AS-525 supports two types of report.

Immediate reports list details of recent movements (within the last few
hours). They are shown in the display area and can be exported.
Archive reports are immediately exported.

8.1 Immediate Reports

There are four types of immediate report:

Who's been in today- Lists where and at what time each user was
granted access for the first time today.

Last known Position- Lists where and at what time today each user
was most recently granted access.

Roll-Call Readers- Lists the last time each reader was accessed, and
by whom, within the last 1-99 hours.

Roll-Call Areas- Lists all users currently within the selected areaq, sorted

by department and entry time. The report lists all personnel who
entered the facility within the last 1-99 hours.

To show an immediate report, select it from the Reports element of the
free-view, under Immediate.

To create a new immediate report:

1. Expand the Reports element and select Immediate from the tree
view.

2. Click the New icon d on the toolbar.
The Immediate Reports Wizard opens.

Step 1 - Report type

o Thereport wizard will help you create a new report,
‘fou can press back. at any time to change pour selections.

What repart do ou wish to produce?
Rl Call - Fieaders |

Cancel | | New> | |

Figure 60: Inmediate Reports Wizard (Step 1)
3. Select areport type and click Next.
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Follow the on-screen wizard instructions until the wizard has
completed. The display area lists the new report.

8.2 Archive Reports

There are three ways of producing archive reports.

Panels events reports

Panel event reports displays details of all recorded panel events.
There are 5 available panel event reports.

Attendance report - Lists the attendance hours for selected users,
sorted by date. Results include hours present, time in and fime out.
Panels report - Lists all the events recorded by the selected panels,
sorted by date.

Access report - Lists all access events recorded by the selected
readers, sorted by reader and date.

Areas report - Lists all users within selected access areas, sorted by
department and date.

Readers report - Lists all users who have accessed the selected
readers, sorted by department and date.

Visitor report - Lists visitors who have made a visit to a certain user or
department, or lists all related visitors.

System AxTrax events report

System AxTrax event reports list details of system and operator activity.
There are 3 available panel event reports.

System report - Lists all operations performed by the AxTrax server,
sorted by date.

Operators report - Lists all the operations performed by registered
system operators, sorted by operation event type and date.
Alarms report - Lists all raised system alarms, sorted by operator and
date.

Interactive report

Interactive reports list details of users and their access activity.

User details - Lists selected users' details, including assigned cards, PIN
and assigned access group.

Users access rights - Lists site access details for selected users, with full
details of readers accessed and in which time zones.

Not responding users - Lists users for whom there have been no
access events for a selected period of time.
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9, Administrator Operations

9.1 Setting the Time and Date

Select panels by network and reset their date and time to the AxTrax
server's system date and time, using the Set Time window.

To reset the panel time:

1. Expand the Networks element on the free view and select a network.

2. Click the Set Time icon - .
The Set Time window opens.

Set time

1. Check the panels for time sefting
2 %et the spstem time
3. Click 'Apply' to sert the new time

Date: 1140342007 Time: e

| Desaiiption Status | Date [ Selectall !
O  1%Panel1 Mot responding - -
O 14Panel2 Not responcing P —
O 14Panel3 Kot respending Q
O 1%Panel4 Not responcing

| Cancel

Figure 61: Set Time window
3. Select the panels to reset and click the Apply button.
The server connects to the panels and sets the time as requested.
A dialog confirms the operation.

9.2 Detecting Panels Automatically

It is possible to search for panels over the access control network. This is
useful during installations; the AxTrax AS-525 finds all connected panels in
the network and checks them. Panels can then be quickly activated and
updated.

To detect panels:

1. Expand the Networks element on the free view and select a network.
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2.

Click the Find Panels icon %’ .
The Find Panels window opens.

Find panels

1. Click 'Test' to detect all panels on the network,
2 Select the new panels for adding and dowrloading data by clicking o the checkbores.
3 Click "Apply’ to download

O sz B

| Descipti... | Panes status | Metwork status t
[u] [ ] ]

< 3>

Please wait

Figure 62: Find Panels window

Select the panels that should be activated.

Click the Apply button to activate the panels and download setup
information.

Once the detection process is complete (may take 2-3 minutes), the
display shows all of the detected panels and their corresponding
information.

Selected panels will then be automatically appended in the Tree
View under current network.

9.3 Manual Download of Panel Data

Operators can manually download specific access-control panel
configurations using the Download Data window. All of the panel’s data
will be downloaded with no data parsing or filtering.

To manually download panel data:

1.

Expand the Networks element on the tree view and expand a
selected network.

Select a panel in the tree view and click the Download Data icon
L
ol

The Download Data window opens.
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| Statuz ‘

Data

Find firmwsare and clear old data
Dowriload Panel configuration
Evwents filter

Panel links

Output Groups

Input Groups

Time Zones

Holidays

Global Antipasshack.

Users

Cards

Mote: Re-nitialize user's counters ocoure.

Cancel

Figure 63: Download Data window

3. Click the Apply button to apply the operations.
9.4 Downloading Failed Data

In the event that some data failed to download into the access control
panels, it is possible to perform a download of the failed operations only.
This operation can be done on a single panel, on all the panels in a
network or on all the panels in the entire system.

To download failed data:

1. Inthe Tree View, select a specific panel, a specific Network or the
entire Networks.

2. Select and click the Download Failed Data icon 4 .

The Download Data icon window opens.

Download data X

1. Check the row for manual dowrload
2. Click *Apply' to dowrload

[ Date | Description [ Panel | Data type | Status A Selectal
a 24/05/2007 45, 0000023458 2WPanel 1 Card
O 24052007 45 0000023453 2Parel  Card
O 2405200 45 0000023460 2Parel1  Card Selectnone
a 24/05/2007 45, 0000023461 2WPanel 1 Card
O 24052007 45 0000023462 2Parel  Card
00 24052007 2\Parel3\Reader] 2\Pareld  Reader I
O 24052007 SMITH Tom 2Parell User
O 24052007 SMITH Tom 2Parel2  User
O  2405:2007  SMITH Tom 2\Parel 3 User Disable
O 24/05/2007  SMITH Tom 2Paneld  User selected
O 24052007 SMITH Tom 2Parels  User
O 24052007 1,0000000105 2Parel2  Card
O 24052007 45, 0000023458 2Panel2  Cad
O 24052007 45 0000023457 2Parel2  Cad
O 24052007 45 0000023458 APanel2 Card
4” AMRHNNT AR AANANT2AR M anel ) e a A

Cancel

Figure 64: Download Data icon window
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3. Select the required parameters to download by checking the
checkbox next to each parameter, you can use to the Select All and
Select none for fast selection.

Click the Enable Selected or Disable Selected button to apply the
status to the selected parameters.

9.5 Testing User Counters

When using User Counters, It is possible to view current User count value in
each panel that has Reader designated with "Deduct User" option.

To view User Counters:
1. Inthe Tree View, select Department\Users then select one User in

Display area.
. . -1
2. Select and click the User Countericon , the Request User Count
window opens.

Counter status Counter value
Enabled 3

2\Panel 1 Enabled 10

2\Panel 2 Enabled 10

2\Panel 3 Enabled 8

2\Panel & Enabled 10

Test Cancel

Figure 65: Request User Count window

3. Click the Test button to read a User Counter in each of the panels.

9.6 Maintaining the Database

The system database is maintained from the Database window.

ill“] This option is only available within the AxTrax Server system.

To open the Database window, select Tools > Database from the menu
bar.
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Database =

Select database options

Periadic backup to computer's ‘lon’ local diectories

Backup folder

C:%Program Files\Rosslare\Veritrax 45-225'BackupiWeriiax5. bak

Browse..
Penmmjackup every ™ Perform backup at
| Days -
b D 0000 =
=4 means no backup
Hale: The selected file name will be appended with _Veriiay_ve
Cancel

Figure 66: Database window

The following database operations are available:

Operation

Description

Periodic Backup

Run a scheduled backup every specified number of
days at the specified time.

Backup now

Run a one-time backup immediately.

Export
Configurations and
Events

Copy the contents of the database to the selected
folder.

Import Replace the current configuration based on the
Configurations imported file.
Import Replace the current configuration and events

Configurations and
Events

based on the imported file.

Erase Configuration
and Events

Erase the current database configuration and all
events.

Import earlier
database versions
from

AS-215

Replace the current database.

Only VeriTrax AS-215 databases from versions 0.5—
2.02.04 and 2.05.00-2.05.05 or newer can be
migrated.

Import earlier
database versions
from VeriTrax AS-225
/ AxTrax AS-525

Replace the current database.

VeriTrax AS-225 or AxTrax AS-525 databases from
versions 0.00.04 or newer can be migrated. Note
that this option does not allow importing a database
from a current AxTrax AS-525 version.
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Operation Description

Limit panel Events Automatically erase events when they are older
period than a specified number of days.

Before using this option, Rosslare recommends that
you set a periodic backup.

Erase panel Events  Erase all events that are older than a specified
number of days.

The Backup and Export functions, add the *_VeriTrax_vX" prefix at
the end of exported or backed-up database. The Import
database function will execute only with the string atf the end of
the file name.

After a database has been imported, the panel status may
change to disabled. If this is the case, the operator should re-
enable the panels.

9.7 AxTrax Options and Preferences

The AxTrax AS-525 can be customized to meet the preferences of the
operator using the Options window.

To open the Options window, select Tools > Options from the menu bar.
The Options window has four tabs:

General startup, presentation and connection preferences
Settings to control AxTrax information pop-ups

Additional user-defined fields for the User Properties window
Report title settings

Startup, Presentation and Connection Options

The General tab includes basic control over AxTrax AS-525 start-up and
security options, user highlighting preferences and fransaction connection
settings.
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General T Fop up T User Fieldz T Report tite
Default zetting Language HASP key
[ Auto startup |English ﬂ I~ Share data base with Veritime
Holidays Spstem
[~ Outlook, el [
-Highlight
¥ Use highlight user events v Use highlight alarm events

™ Selected user [~ Selected alams

v Alluzers Default calar [V & slarms Diefault color

v Unknown key Default color

[

-Use highlight Hetworks and Panel status

Metwork falled

Default color Drefault color

!

Tranzmit rangactions

JIE

™ Com part Speed | o
QK. ‘ Cancel |
Figure 67: General tab
The General tab contains the following fields:
Field Description
Auto startup Enable the checkbox to start the AxTrax AS-525

automatically when the computer is turned on.

Language Select the system interface language. This option will
temporarily switch language unfil you close AxTrax AS-
525. Permanent language settings are set under
Operators options.

HASP Key Enable this checkbox if the system consists of less than
64 panels and you require the operation of the installed
VeriTime attendance software. This is possible by
checking if VeriTime option is selected in the HASP key.

Outlook Enable the checkbox to load Microsoft Outlook™
holidays into the AxTrax AS-525.
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Field Description

Select Holiday Click the button to select Microsoft Outlook™ holidays
to load into the AxTrax AS-525.

This button is only available when the Outlook
checkbox has been enabled.

Show download Enable the checkbox to add a message to event
succeed history upon successful system parameters download
from the AxTrax AS-525 software to the panel.

Use highlight user Enable the checkbox to display selected user
events information in a colored highlight.

Selected user /  Enable one of the checkboxes to highlight either
All users selected users or all users.

When Selected Users is enabled, users are highlighted
when they have been marked for highlighting in the
User Properties window.

See General User Properties, page 45.

Unknown key Enable this checkbox to highlight every record of
aftempted access by an unknown card or PIN.

Use highlight Enable the checkbox to highlight selected alarm
alarm events events.

Selected alarms / Enable one of the checkboxes to highlight either
All alarms selected or all alarms.

Alarms are selected if they have been marked for
highlighting in Panel Links window.

If All Alarms is enabled, all alarms are highlighted.
See Setting Panel Links, page 53.

Use highlight This option can be used to quickly identify panels that
Network and are not responding or networks, which include panels
Panels that are not responding.

When selecting the root "Networks" tree view, Networks
with panels that are not responding are highlighted
with the selected color on display area.

When selecting a specific Network on tree view, panels
that are not responding will be highlighted with the
selected color on display area.

Panels that are currently disabled are not considered
as "not responding".

Select color Click to select a color for highlighting.
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Pop-up Options

The Pop-up tab conftrols the behavior of pop-up Event alarms in the

system.

Events

Dizplay window

General

™ Enable pop up alarm window.

Enable pop up user window [Server application only].

™ Access Granted
[ Access Denied
[ Access Recorded

™ Standard user window

&+ | arge picture

T Uszer Fields T Fieport title

Clozed by
* Manual

’—_ [mir:gec]

" Timer

(u].8 Cancel

Figure 68: Pop-Up tab

The Pop-up tab contains the following fields:

Field

Description

Enable pop-up
alarm window

Enable this checkbox to activate pop-up alarm
notifications.

Access Granted

Enable this checkbox to display a pop-up nofification
whenever a reader grants a user access. This option is
only available from the AxTrax server.

Access Denied

Enable this checkbox to display a pop-up notification
whenever a reader denies a user access. This option is
only available from the AxTrax server.

Access Recorded

Enable this checkbox to display a pop-up notification
whenever an "access recorded” event occurs.

This option is only available from the AxTrax server.

Closed by
Manual / Timer

Select to close display pop-ups either manually, or after
a set duration.
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Field Description
Display Window Use to determine which of the User’'s windows to pop-
up.
User Defined Fields

The User Fields/Default tab controls the fields on the User Fields tab of the
User Properties window and the Valid Data default value. See User
Defined Data, page 50.

General T Pop up/Shared T 4 Fieport title

Uszer Fields

Field dezcription

| Text
Field type List
| Test j Check [+
Drescription | Type | Add

Remove

v Default valid time

From Until
oo == 235 -
ak. Cancel
Figure 69: Options Tab
The Options tab contains the following fields:
Field Description
Field description  Enter a name for the new field.
Field type Select the type of field.
Add Click to add this field.
Remove Click to delete the selected field.
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Field Description

Default/Valid Time Default time for user access rights to begin and end.
This field is only available when the check box
has been enabled.

Report Title Settings

The Report title tab controls basic presentation preferences for the reports
generated by the AxTrax AS-525.

Gereral T Pop up | User Fields T Report title

Company name Logo

Rosslare| ]

Fort... 1 Add ‘

Company details

Rosslare Security Products

[ Show report title

OK. | Cancel

Figure 70: Report Title tab
The Report title tab contains the following fields:

Field Description

Company Name Enter the company name to be shown on reports.

Font Click to set a font and color for the company name.

Company details Enter the company address.

Show report title  Enable the checkbox to display this company name
and logo on the reports.

Logo Add / Clear Click to select alogo to be printed on reports.
If a logo has already been selected, click fo remove it.

9.8 Importing User Data

The Import Data window makes it possible to import user information into
the AxTrax database from a standard spreadsheet file.
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Import Data
Import Lisers propeties from evtemal fle into AxTrax AS-525 Data lype
Excel workhook - s -
Excel file
Lacation:
Started from
Excelfil Fow  User Number started fiom— Import Depatiment
1 1 ®Yes C No [ |
Excel fils Colunins
I~ - First name I~ - Mobie I™ K- Car egistration
I~ L~ Tile
™ M'-Notes
™ N'-PIN Code
I~ 4" Home telephane
Cancel

Figure 71: Import Data
The Import Data window contains the following fields:

Field Description

Data Type Select the type of data to import.

Location The location of the file to import.

Browse Click to select the file to import.

Excel file Row Enter the first row of user data in the spreadsheet.
User number Enter the number from which to start assigning unique
started from system user numbers.

Import Select Yes to import new departments into the AxTrax

Departments? database.
Select No to import users without their departments.

Department Select the department to assign to the imported users.
This box is only active when the Yes button is selected.

Excel File Enable the columns to be imported.

Columns Data in each column (A—M) will be imported as listed.
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Appendix A. Firewall Configuration

The following instructions explain how to configure the standard Windows
Firewall for Windows XP.

To configure the firewall:

1. Click the My Computer icon on the deskfop.
The My Computer folder opens.

2. Select the Address Bar and type "Control Panel". Hit the Enter key.
The Windows Control Panel opens.

Fle Edt View Favorites Tools Help

QBak » ) (¥ Osearch [ Folders

Pick a category
rz@ App nd Themes

" Network and Internet Connections
-

i J) Sounds, Speech, and Audio Devices

@

Figure 72: Windows Control Panel
3. Click the Security Center category.

(If the Conftrol Panel is in "Classic View", click Switch to Category View
in the top-left Control Panel preferences pane and click the Security
Center category.)

The Windows Security Center opens.
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© Windows Security Center

@ Security Center

Help protect your PC

@ Security essentials
i

s windows To help protect your computer,

kO, follow the

E
+ Gt the latost security and virus recammendations. Ta return ta the Securty Center later, open Cantrol Panel
What's new n Windows to

© Check for the latest updates from

Windans Update @aFirevall

O ON ¥
* Get support for security-related
2 4@ Automatic Updates O ON ¢
et help sbout Securty Center
{Ghenge the way Sty Cenfer J Virus Protection @ ON | ¥
densme

Manage security settings for:

[ﬁ Automatic Updates
@ Windows Firevall

Intetet Options

Figure 73: Windows Security Center
4. Click Windows Firewall.

The Windows Firewall opens.
Select the Exceptions tab.

ndows Firewall

General | Exceptions | Advanced

Windaws Firswallis blocking incoring netwark connections, excapt for the
progiams and services selected below. Adding exceptians alows same progiams
ta work better but might increase yaur security risk.

Programs and Services:

ppiication Sharing
SPO1 Configuration Lty

HCF Discovew Service

igi0p FiemateManager Application
igiT ool Cal Cenler

le and Printer Sharing

I Intelinar 1P lnstaller

[E3

[ AddProgram.. | [ AddPor. | [ Edt ] [ Delete

Display a nofifisation when Windovs Firewall blocks & program

‘w'hat are the risks of sllowing exceptions?

Figure 74: Windows Firewall
5. Click Add Program.

The Add a Program dialog appears.
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11.

12.

Add a Program gl

Ta allow communications with a pragram by adding it to the Exceptions list,
select the program, or click Browse to search for one that iz not listed.

Programs:
{8l Solitaire ~
£| Spider Solitaire
j SGL Server Enor and Usage Reporting
(&1]S0L Server Surface Area Canfiguration
i TransferlserData
@ UD Agent
m Uninstal
71 Uninstall DeepBumer
w SOL
I wirdmage
Bwiow 7

Path: | C:\Program Files\Rasslare\VeritraxS 0L Weri Tre

Figure 75: Add a Program to the Firewall List

Click Browse.
The Browse dialog appears.
In the File Name box, type:

"C:\Program Files\Microsoft SQL
Server\MSSQL.1\MSSQL\BINN\sqlservr.exe"

Hit Enter.
The sqlservr program appears in the Add a Program dialog.
Select the program and click OK.

The sqlservr program appears on the Windows Firewall list of
exceptions.

Repeat steps 5 and 6. In the File Name box, type:

"C:\Program Files\Microsoft SQL Server\90\Shared\sqglbrowser.exe"
Hit Enter.
The sglbrowser program appears in the Add a Program dialog.

. Select the program and click OK.

The sglbrowser program appears on the Windows Firewall list of
exceptions.

Click OK.

Repeat steps 1 and 2.

The Control Panel window opens.

Click the Perfformance and Maintenance category.
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(If the Control Panel is in "Classic View", click Switch to Category View
in the top-left Control Panel preferences pane and click the
Performance and Maintenance category.)

The Performance and Maintenance window opens.

® Performance and Maintenance

File Edit View Favorites Tools Help
Qeack » 3 (F Osearch [ Foders  [Tw

ackiress | O Performance and Maintenance

4 4 Performance and Maintenance
C_J

See Also

Fil: Types

@ Systen Restors Pick a task...

‘Troubleshoote’ [3) see basic information about your computer
[2] startup and shutdonn I e e
[5) Free up space on your hard disk

[3) Rearrange items on your hard disk to make pragrams run faster

or pick a Control Panel icon

OFc administrative Tools B3, Power options

‘ Scheduled Tasks :‘I System

Figure 76: Performance and Maintenance window
13. Click Administrative Tools.
The Administrative Tools window opens.

% Administrative Tools FEX
Fie Edt View Favarites Took Help a
@Back - ) (¥ O search [ Folders [T+
Addvess | 4 Administrative Tools v B

File and Folder Tasks ) @ ;%? @’;ﬁ I%}

Componert  Computer  Data Sources Evert Viewer Performance  Services
B2 shars this folder Services  Mamagement  (ODBC)
Other Places

@ control Panel
My Documents

[ shared Documents
i My Computer
3 My Network Places

Details

Administrative Tools
System Folder

Figure 77: Administrative Tools window
14. Double-click on the Services icon. The Services Console opens.
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% Sarvices
File Acion Wiew Help
| =) B LI
| z
3y Services (Local) e el
Windows Firewall/Internet Hame: | Description | status | &
Connection Sharing (1C5) B Themes Prowides u...  Started
o S Uninterruptible Pow, .. Manages a...
0] e service
i i yniversal Plugand ... Provides s...
Hovolume Shadow Copy  Manages ...
N “nwebClient Enables Wi... Started
escription:
Frocs netuork sctress ranlston,  WWDdows fude | Hanages o, Started
addressing, name resolution and/ar rewallfIn. .. Provi ® arted
intrusion prevention services for a home %Wmdows Image Ac..,  Providesim.., Started
o small office network. B windows Installer  Adds, modi..,
Swindows Managem,., Providesa ... Started
S windaws Time Mainkains d... Started
%Wweless Zero Confi...  Provides a...
Bl Performance A... Provides ...
S workstation Crestssan.. Statsd
< | 3
%, Extended A Standard

Figure 78: Services Console

15. Right click on Windows Firewall/Internet Connection Sharing (ICS).
Click Restart from the pop-up menu.

16. Right click on SQL Server. Click Restart from the pop-up menu.

17. Right click on SQL Server Browser. Click Restart from the pop-up menu.
The Firewall is now configured for AxTrax AS-525.
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Appendix B. SQL Service Settings

In order to reach the SQL Service Settings, click on the following path from
the Control Panel in Windows XP:

Control Panel > Administrative Tools > Services and Applicatfions > Services
> SQL Server (VERITRAX).

Double click on "SQL Service (VERITRAX)" to receive the following dialog:

SQL Server (VERITRAX) Properties (Local Computer) @@

General | Log On | Recavary | Dependencies

Service name: MESOLEVERITRAX

Display name:

Description Provides storage, processing and controlled access of
- data and rapid transaction processing

Path to executable:
"ChProgram Files\Microsoft S0OL SererMSSOL 1S SALBinnisglservr.exe” -s*

Startup type: Autarmatic ~

Service status: Started

Stop I l Pause

“ou can specify the start parameters that apply when you startthe senvice from
here.

Figure 79: SQL Service Settings

Under the General tab, verify that the Startup type is *Automatic” and
that the Service status is “Started”
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SQL Server (VERITRAX) Properties (Local Computer) @R‘
General| Log On |Recovery | Dependencies

Log on as

(@ Laocal System account

[T Allow service to interact with deskiop

(O) This aceourt

You can enable or digahle this service for the hardware profiles listed below.

Hardware Profile Senrvice
Profile 1 Enabled

Figure 80: SQL Service Log On

In the Log On tab, verify that the Local System Account radio button is
selected. If not, select the Local System Account and restart the
computer for the changes to take effect.
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Appendix C. Network Configuration

The AxTrax Server connects to access control units by a serial connection,
a TCP/IP connection or a Modem-to-Modem connection.

To connect access control panels to the AxTrax AS-525 over a TCP/IP LAN
(Local Area Network) or WAN (Wide Area Network), the use of a TCP/IP to
Serial converters required unless the panel has onboard TCP-IP connection
(AC-225IP or AC-525).

Each TCP-IP connection can supports up to 32 access control panels
connected using RS-485 with each other.

The hardware used to connect to TCP-IP network may be the MD-N32
which is a Serial to Ethernet converter, or using the onboard converter of
AC-225IP or AC-525.

You can also use Rosslare’'s MD-N33 modem for Modem to modem
connection. Refer to the hardware installation manuals of the desired
panel for more details.

TCP/IP and Modem-to-Modem connections must be configured for use,
and require expert knowledge of the local network.

To configure TCP-IP Connection for AxTrax AS-525:

1
1. Inthe tree view, click on Networks. Click the Edit icon d on the

toolbar. The Networks window opens.
2. Setthe Network type as TCP/IP.

¢ If you want to work with Remote in TCP/IP Network window
» select Remote (WAN), and add the WAN IP Address of the PC.

3.  Click the Configuration button.
The TCP/IP Configuration window opens.
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TCP/IP Configuration

Configuration
Gateway

WD - N32 st [ Status | Confiquiation
B0005DCI1.CEEI  Avalsble  Local (LAN]MDHP32 =
3|0008DC12374E Metwork 1 Looal [LAN] MO-N32 S
Ci{0008DC1Z40HE Mewok 3 Local (LANI MD-N32 Local IP Addiess

3000800124018 Avalable  Local [LAN) MO-N32 192 jiee 2 4o
Subnet
255 I 255 I 255 ) 0

Gateway

i

Speed Lacal Part

57600 ~| 1000

Apply
Search options
¢ Direct MAC address | A & AN M A
£ Direct IF fddiess — I
& AIMDN2
ax Cancel

Figure 81: TCP/IP Configuration window

The upper left window lists all TCP/IP converters attached on the local
network, identified by their MAC address, and if they are available to
assign to a new panel network or are already assigned.

4.

Select the appropriate MAC address from the MD-N32 list (The MD-
N32's MAC address should be labeled on the TCP/IP converter).

In "Gateway Type" select the type of TCP/IP converter, MD-N32, MD-
IP32 On board, or any other valid option. Skip this selection if it is
already valid.

In the appropriate fields, enter the Local IP address and Subnet for
the computer's network.

Enter the Port number and select the speed of your connection. It is
recommended to select a higher value port number (4001 or higher).
Note that the selected should not end with zeros (prefer setting Port
value of 4243 rather than 4200). This will avoid colliding with port
addresses reserved for various equipment installed on the same
network.

Click OK to start the verification process.

Click OK twice and verify that the AxTrax AS-525 software accepted
the configuration.

Turn off the MD-N32 power (or panel power if using the onboard
module, such as MD-IP32) and than turn power on again. This step is
necessary when using certain versions of MD-N32 or MD-IP32 models.
Skip this step if not applicable.

If configuration applies to WAN network, disconnect the configured
unit from the local network and re-connect to the WAN network and
access control panels network working over the WAN.
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To configure MD-N33 in AxTrax:
1.  Add a new network in AxTrax software.

2.  Under network type select Modem.
retwork 5

Desoription
Network 2 (z

W Ensbled

Netwark ype
Modem hd
Modem Network

Com Part
COM1 -~

Speed

9600 A

[al Cancel
Figure 82: AxTrax AS-525 Modem Network

¢ Communication speed is limited to 9600, 19200, 57600, or 115200
" bits per second.

To Initialize and Configuring the Computer Modem
1. Inthe Network window, click the Configuration button.
The Modem Configuration window opens.

Modem configuration =
PC modem 1 Remale modem
Diaing

Remale modem phone number

Nurnber of dial attempts
1 -
Additional dialing string options

¥ Use default

Dialing schedule -
[Hever =

-

Settings

Initisfization string

' Use defauit

Apply
QK Cancel

Figure 83: AxTrax AS-525 Computer Modem Configuration
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2.

In the Dialing area, under Remote modem phone number, enter the
destination telephone number to call.

Click to change the Number of dial attempts (if required).
For most applications, the default dialing string is sufficient.
The dialing string is displayed in the window.

Clear the Use default checkbox. This allows adding or editing of the
dialing string. Then type the AT command in the Dialing string
window.

Select the time zone from the Dialing schedule drop down list.

Choose the disconnecting condition: "Disconnect by schedule end"
or "Disconnect on upload complete”.

(This option is enabled when the selected time zone is different from
the default fime zone (Always & Never).

In the Settings area the initialization string is displayed in the window.
For most applications, the default initialization string is sufficient.

Clear the Use default checkbox to allow adding or editing of the
dialing string. Then type the AT command in the Dialing string
window.

Connect the computer's modem to the PC via the selected COM
port and click "Apply" to initialize the PC modem.

. Click OK to complete the initialization.
. If the computer displays a failure message, check the modem

connections and repeat the last steps.

Remote modem initiclization is at the PC side. When modem
initialization fails through telephone line, a message appears.

Initializing and Configuring the Remote Modem
To initializing and configure the remote modem.

1.

In the Modem Configuration window, click the Remote modem tab.
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Modem configuration =
PC madem Il Remole modem
Settings
Iniialzation sling
I W Use defauit
Nurber of ings to answer
1> Aeply
(i3 Cancel

Figure 84: AxTrax AS-525 Remote Modem Configuration

2. Inthe Settings area the initialization string is displayed in the window.
For most applications, the default initialization string of AS-525is
sufficient.

3. Clear the Use default checkbox to allow adding or editing of the
dialing string. Then type the AT command in the Dialing string
window.

4. Set the number of rings before the computer modem answers.

Connect the remote modem to the computer via the selected com
port and click Apply to initialize the computer modem.

Click OK to initialize.

If a failure message appears, check the modem connections and
repeat the last steps.

¢ You must perform the action twice at the PC side, fo Initialize
. two MD-N33's.

The MD-N33 and AxTrax AS-525 software are now configured and ready.
(You can now continue working using the AxTrax Adding New Panel
procedure).

To check the remote modem status:

1. When panel is setting in a modem network, you can see the status of
the modem by clicking the phone icon in the toolbar.

2.  There is a manual option fo dial or disconnect the modem.
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todem status

Metwark, | Phaone number | Statuz | Duration \
Network 4 102 Cornected 2 Minutes
Network B 104 Connected 2 Minutes

Disconnect | Close |

Figure 85: AxTrax AS-525 Modem Status

3. Inorder to prevent access to AxTrax data from non-authorities users,
the AC-215, AC-225 or AC-525 access confrol panels contain a
password that can be changed only when the modem is connected
and there is a link with the panel.

* The default password for the modem configuration and status
. screens is VeriTrax.

You may be asked to enter the password during first data
configuration, such as adding a new panel or downloading a new
firmware.

Confirm modem password for the network Networl: 4

Currert Password I
Mew Password: I
Confim New Password: I

I™ {lise defaul [VerTra |

QK | Cancel |

Figure 86: AxTrax AS-525 Modem Security

Restoring Factory Default Settings

If the modem configuration password is lost or forgotten, reset the access
control panel to the factory default settings and use the default "VeriTrax"
password.

Page 103 AS-525 AxTrax Software Installation and User Guide



Network Configuration

Caution:

Restoring factory default settings resets all doors and reader
configurations to their factory defaults and clears all user
properties.

To restore the factory default settings:

1.

Turn off the supply power.
Disconnect all doors and readers wiring.

Connect Data 0, Data 1 and Tamper inputs to GND (-) in both reader
1 and 2 (total of 6 wires)

Power up the supply power for few seconds. Wait for the "LED3" and
"LED4" LEDs to flash alternately.

Turn off the supply power.
Connect the doors and readers wiring again.

In AxTrax AS-525, delete the panel by clearing the Enable panel
checkbox in the panel screen. Click OK.

Check the Enable panel checkbox in the panel screen and click OK.
This action causes a full reset of the access control panel with the
factory settings.

Dial to the appropriate access control panel and click on password in
the modem status screen. Use AxTrax as the current password and
change the password to a new one.
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Appendix D. Technical Support

Asia Pacific, Middle East, Africa
Rosslare Security Products Headquarters
905-912 Wing Fat Industrial Bldg,

12 Wang Tai Road,
Kowloon Bay Hong Kong
Tel: +852 2795-5630
Fax: +852 2795-1508

E-mail: support.apac@rosslaresecurity.com

United States and Canada
1600 Hart Court, Suite 103
Southlake, TX, USA 76092
Toll Free:  +1-866-632-1101
Local: +1-817-305-0006
Fax: +1-817-305-0069

E-mail: support.na@rosslaresecurity.com

Europe
Global Technical Support & Training Center

HaMelecha 22

Rosh HaAyin, Israel 48091
Tel: +972 3 938-6838
Fax: +972 3 938-6830

E-mail: support.eu@rosslaresecurity.com

South America
Pringles 868, 1640 Martinez

Buenos Aires, Argentina

Tel: +54 11 4798-0095

Fax: +54 11 4798-2228

E-mail: support.la@rosslaresecurity.com

Web Site: www.rosslaresecurity.com
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